# Table of Contents

**IP Facts**

**Chapter 1: Overview**
- Applications ........................................................................................................................................ 5
- Unsupported Features ......................................................................................................................... 5
- Licensing and Ordering Information .................................................................................................. 6

**Chapter 2: Product Specification**
- Introduction .......................................................................................................................................... 7
- Standards ........................................................................................................................................... 16
- Performance and Resource Utilization ................................................................................................. 17
- Port Descriptions ................................................................................................................................. 17
- Clocks and Resets ............................................................................................................................... 34

**Chapter 3: Designing with the Subsystem**
- General Design Guidelines .................................................................................................................. 35
- Interlaced Video ................................................................................................................................. 42
- Clocking ............................................................................................................................................. 44
- Resets ................................................................................................................................................ 48

**Chapter 4: Design Flow Steps**
- Customizing and Generating the Subsystem ....................................................................................... 49
- Constraining the Subsystem ................................................................................................................ 58
- Simulation ......................................................................................................................................... 60
- Synthesis and Implementation ............................................................................................................ 60

**Chapter 5: Example Design**
- Summary ............................................................................................................................................ 61
- Running the Example Design .............................................................................................................. 68

**Appendix A: Verification, Compliance, and Interoperability**
- Interoperability ................................................................................................................................. 86
- Hardware Testing ............................................................................................................................... 86
- Video Resolutions ............................................................................................................................... 87
Appendix B: Migrating and Upgrading
Upgrading in the Vivado Design Suite ................................................................. 92

Appendix C: Debugging
Finding Help on Xilinx.com ............................................................................. 94
Debug Tools ........................................................................................................... 95
Hardware Debug ................................................................................................. 96
In-system Debug ................................................................................................. 97
Interface Debug ................................................................................................. 100

Appendix D: Application Software Development
Device Drivers .................................................................................................... 102

Appendix E: Additional Resources and Legal Notices
Xilinx Resources ................................................................................................. 119
Documentation Navigator and Design Hubs ................................................... 119
References ........................................................................................................... 120
Revision History ................................................................................................. 121
Please Read: Important Legal Notices ............................................................ 122
Introduction

The HDMI 1.4/2.0 Transmitter Subsystem is a hierarchical IP that bundles a collection of HDMI® TX IP sub-cores and outputs them as a single IP. It is an out-of-the-box ready-to-use HDMI 1.4/2.0 Transmitter Subsystem and avoids the need to manually assemble sub-cores to create a working HDMI TX system.

Features

- HDMI 2.0 and 1.4b compatible
- 2 or 4 symbol/pixel per clock input
- Supports resolutions up to 4,096 x 2,160 @ 60 fps
- 8, 10, 12, and 16-bit Deep-color support
- Support color space for RGB, YUV 4:4:4, YUV 4:2:2, YUV 4:2:0
- Support AXI4-Stream Video input stream and Native Video input stream
- Audio support for up to 8 channels
- High bit rate (HBR)
- Info frames
- Data Display Channel (DDC)
- Hot-Plug Detection
- 3D video support
- Optional High Bandwidth Digital Content Protection (HDCP) 1.4 support
- Optional HDCP 2.2 support
- Optional Video over AXIS compliant NTSC/PAL Support
- Optional Video over AXIS compliant YUV420 Support
- Optional HPD Active polarity

LogiCORE™ IP Facts Table

<table>
<thead>
<tr>
<th>Subsystem Specifics</th>
<th>Supported Device Family</th>
<th>Supported User Interfaces</th>
<th>Provided with Subsystem</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>UltraScale+TM Families (GTHE4, GTYE4)</td>
<td>AXI4-Lite, AXI4-Stream</td>
<td>Design Files RTL</td>
</tr>
<tr>
<td></td>
<td>UltraScale™ Architecture (GTHE3)</td>
<td></td>
<td>Example Design Vivado IP Integrator and associated software application example</td>
</tr>
<tr>
<td></td>
<td>Zynq®-7000 SoC</td>
<td></td>
<td>Test Bench Not Provided</td>
</tr>
<tr>
<td></td>
<td>7 Series (GTXE2)</td>
<td></td>
<td>Constraints File XDC</td>
</tr>
<tr>
<td></td>
<td>Artix®-7 (GTPE2)(2)</td>
<td></td>
<td>Simulation Model Not Provided</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Supported S/W Driver Standalone, Linux</td>
</tr>
</tbody>
</table>

Tested Design Flows

- Design Entry Vivado® Design Suite
- Simulation Simulation is not supported for HDMI Transmitter Subsystem
- Synthesis Vivado Synthesis

Support

Provided with Xilinx at the Xilinx Support web page

Notes:

1. For a complete list of supported devices, see the Vivado IP catalog.
2. Only HDMI 1.4 is supported in Artix and Kintex -1 devices.
3. Standalone driver details can be found in the SDK directory (<install_directory>/SDK/<release>/data/embeddedsw/doc/xilinx_drivers.htm). Linux OS and driver support information is available from the Xilinx Wiki page.
4. For the supported versions of the tools, see the Xilinx Design Tools: Release Notes Guide.
Overview

The HDMI 1.4/2.0 Transmitter Subsystem is a feature-rich soft IP incorporating all the necessary logic to properly interface with PHY layers and provide HDMI® encoding functionality. The subsystem is a hierarchical IP that bundles a collection of HDMI TX-related IP sub-cores and outputs them as a single IP. The subsystem takes incoming video and audio streams and transfers them to an HDMI stream. The stream is then forwarded to the video PHY layer.

The subsystem can be configured at design time through a single interface in the Vivado® Integrated Design Environment (IDE) for performance and quality.

Applications

High-Definition Multimedia Interface (HDMI) is a common interface used to transport video and audio and is seen in almost all consumer video equipment such as DVD and media players, digital televisions, camcorders, mobile tablets and phones. The omnipresence of the interface has also spread to most professional equipment such as professional cameras, video switchers, converters, monitors and large displays used in video walls and public display signs.

For tested video resolutions for the subsystem see Appendix A, Verification, Compliance, and Interoperability.

Unsupported Features

The following features are not supported in this subsystem:

- Lip sync
- CEC
- HEAC
- HDMI 2.0 dual view
- HDMI 2.0 multi stream audio
Chapter 1: Overview

Licensing and Ordering Information

License Checkers

If the IP requires a license key, the key must be verified. The Vivado® design tools have several license checkpoints for gating licensed IP through the flow. If the license check succeeds, the IP can continue generation. Otherwise, generation halts with error. License checkpoints are enforced by the following tools:

- Vivado synthesis
- Vivado implementation
- write_bitstream (Tcl command)

**IMPORTANT:** IP license level is ignored at checkpoints. The test confirms a valid license exists. It does not check IP license level.

If a Hardware Evaluation License is being used, the core stops transmitting HDMI Stream after timeout. This timeout is based on system CPU clock. For example, if system is running at 100 Mhz, the IP times out after approximately 4 hours of normal operation when Hardware Evaluation License is being used.

License Type

This Xilinx® LogiCORE™ IP module is provided under the terms of the Xilinx Core License Agreement. The module is shipped as part of the Vivado® Design Suite. For full access to all subsystem functionalities in simulation and in hardware, you must purchase a license for the subsystem. Contact your local Xilinx sales representative for information about pricing and availability.

For more information, visit the Xilinx HDMI web page.

Information about other Xilinx LogiCORE IP modules is available at the Xilinx Intellectual Property page. For information on pricing and availability of other Xilinx LogiCORE IP modules and tools, contact your local Xilinx sales representative.
Product Specification

This chapter includes a description of the subsystem and details about the performance and resource utilization.

Introduction

Because the HDMI 1.4/2.0 Transmitter Subsystem is hierarchically packaged, you can configure it by setting the parameters in the Vivado® Integrated Design Environment (IDE) interface and the subsystem creates the required hardware accordingly.

A high-level block diagram of the HDMI 1.4/2.0 Transmitter Subsystem is shown in Figure 2-1.

The HDMI TX Subsystem is constructed on top of an HDMI TX core. Various supporting modules are added around the HDMI TX core with respect to your configuration. The HDMI TX core is designed to support native video interface, however many of the existing video processing IP cores are AXI4-Stream based. It is a natural choice to add some supporting modules (Video Timing Controller and AXI4-Stream to Video Out Bridge) to construct HDMI TX Subsystem to be able to support AXI4-Stream based video. By performing this, HDMI TX Subsystem is able to work seamlessly with other Xilinx video processing IP cores.

![Figure 2-1: Subsystem Block Diagram](image-url)
The HDMI TX Subsystem has a built-in capability to optionally support both HDCP 1.4 and HDCP 2.2 encryption.

Figure 2-2 shows the internal structure of the HDMI TX Subsystem when **AXI4-Stream Video Interface** is selected as video interface. In this illustration, both HDCP 1.4 and HDCP 2.2 are selected and both Video over AXIS compliant NTSC/PAL Support and Video over AXIS compliant YUV420 Support are selected.

The HDMI 1.4/2.0 Transmitter Subsystem supports two types of video interface:

- AXI4-Stream Video Interface
- Native Video Interface

Figure 2-2: HDMI TX Subsystem Internal Structure in AXI4-Stream Video Interface Mode

The HDMI TX Subsystem also provides an option to support a native video interface. When **Native Video Interface** is selected, the HDMI TX Subsystem is constructed without the Video Timing Controller and AXI4-Stream to Video Out Bridge. Therefore, the HDMI TX Subsystem is allowed to take native video from its own video devices and convert into HDMI signals. In native video mode, the HDMI TX Subsystem still has a built-in capability to optionally support both HDCP 1.4 and HDCP 2.2 encryption.

Figure 2-3 shows the internal structure of the HDMI TX Subsystem when **Native Video Interface** is selected as video interface. In this illustration, both HDCP 1.4 and HDCP 2.2 are selected.
The data width of the video interface is configured in the Vivado IDE by setting the **Number of Pixels Per Clock on Video Interface** and the **Max Bits Per Component** parameters.

The audio interface is a 32-bit AXI4-Stream slave bus, which transports multiple channels of uncompressed audio data to the subsystem.

The CPU interface is an AXI4-Lite bus interface, which is connected to a MicroBlaze™, Zynq®-7000 SoC, or Zynq UltraScale™+ MPSoC processor. Multiple submodules are used to construct the HDMI TX Subsystem and all the submodules which require software access are connected through an AXI crossbar. Therefore, the MicroBlaze, Zynq-7000 SoC, or Zynq UltraScale+ MPSoC processor is able to access and control each individual submodules inside the HDMI TX Subsystem.

**IMPORTANT:** *The direct register level access to any of the submodules is not supported.*

The HDMI TX Subsystem device driver has an abstract layer of API to allow you to implement certain functions. This AXI4-Lite slave interface supports single beat read and write data transfers (no burst transfers).

The subsystem converts the video stream and audio stream into an HDMI stream, based on the selected video format set by the processor core through the CPU interface. The subsystem then transmits the HDMI stream to the PHY Layer (Video PHY Controller) which
converts the data into electronic signals which are then sent to a HDMI sink through a HDMI cable.

The subsystem also supports the features described in the following sections.

**Audio Clock Regeneration Signals**

The transmitter audio peripherals provide a dedicated Audio Clock Regeneration (ACR) input interface.

The audio clock regeneration architecture is not part of the HDMI TX subsystem. You must provide an audio clock to the application. This can be achieved by using an internal PLL or external clock source, depending on the audio clock requirements, audio sample frequency and jitter. When HDMI TX subsystem is used in DVI mode, the ACR inputs are ignored. You can decide to leave them open or connect them to some fix values (for example, connecting acr_cts, acr_n, and acr_valid to 0). See Chapter 5, Example Design for an example ACR module that is part of the audio pattern generation system.

**Display Data Channel (DDC)**

The subsystem allows the end-user to build an HDMI source device, which negotiates with the targeted HDMI sink device for supported features and capabilities. The communication between the source device(s) and the sink device is implemented through the DDC lines, which is an I2C bus included on the HDMI cable.

**Status and Control Data Channel (SCDC)**

The subsystem supports following two bits in SCDC register address offset 0x20 for TMDS configurations (Table 10-19 of HDMI 2.0 spec).

- Bit 1 TMDS_BIt_Clock_Ratio
- Bit 0 Scrambling_Enable

  Automatically handled by HDMI TX subsystem driver at Stream Start through the API.

- XV_HdmiTxSs_StreamStart

Two underlining subcore API drivers are called to set the above two SCDC bits with respect to the video stream to sent.

- XV_HdmiTx_Scrambler(InstancePtr->HdmiTxPtr); is to used to:
  - Enable HDMI TX scrambler for HDMI 2.0 video and disable scrambler for HDMI 1.4 video stream.
  - Update scrambler bit in Sink's TMDS Configuration register
• `V_HdmiTx_ClockRatio(InstancePtr->HdmiTxPtr)`; is to set TMDS Clock Ratio bit for HDMI 2.0 video.

An API is also available at HDMI TX Subcore driver to show the sink's SCDC register values. (For debugging or advanced use cases)

```c
void XV_HdmiTx_ShowSCDC(XV_HdmiTx *InstancePtr);
```

### Hot Plug Detect

The subsystem supports the Hot Plug Detect (HPD) feature, which is a communication mechanism between HDMI source and HDMI sink devices. For example, when an HDMI cable is inserted between the HDMI source and sink devices, the HPD signal is asserted, which triggers the subsystem to start communicating with the sink device.

**IMPORTANT:** The HPD from HDMI Sink is at 5V. Therefore, a level shifter is required before connecting it to the corresponding FPGA input pin in HDMI Transmitter Subsystem design. For example, if the HPD pin of the HDMI Transmitter Subsystem is at 3.3v bank, a level shifter is required to translate HPD signal from 5v to 3.3v.

### AUX Packs

For HDMI, all data island packets consist of a 4-byte packet header and a 32 bytes of packet contents. The packet header, represented in Figure 2-4, contains 24 data bits (3 bytes) and 8 bits (1 byte) of BCH ECC parity.

<table>
<thead>
<tr>
<th>Byte</th>
<th>Bit #</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>HB0</td>
<td>Packet Type</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HB1</td>
<td>packet-specific data</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HB2</td>
<td>packet-specific data</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ECC</td>
<td>ECC</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 2-4: Packet Header**

The packet body, represented in Figure 2-5, is made from four subpackets; each subpacket includes 56 bits (7 bytes) of data and 8 bits (1 byte) of BCH ECC parity.
Table 2-1: Hardware and Software Packet Types

<table>
<thead>
<tr>
<th>Packet Type Value</th>
<th>Packet Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x00</td>
<td>Null</td>
</tr>
<tr>
<td>0x01</td>
<td>Audio Clock Regeneration (N/CTS)</td>
</tr>
<tr>
<td>0x02</td>
<td>Audio Sample (L-PCM and IEC 61937 compressed formats)</td>
</tr>
<tr>
<td>0x03</td>
<td>General Control</td>
</tr>
<tr>
<td>0x04</td>
<td>ACP Packet</td>
</tr>
<tr>
<td>0x05</td>
<td>ISRC1 Packet</td>
</tr>
<tr>
<td>0x06</td>
<td>ISRC2 Packet</td>
</tr>
<tr>
<td>0x07</td>
<td>One Bit Audio Sample Packet</td>
</tr>
<tr>
<td>0x08</td>
<td>DST Audio Packet</td>
</tr>
</tbody>
</table>

Notes:
1. ECC is calculated in HDMI 1.4/2.0 Transmitter Subsystem core. Therefore, you must construct HB0…HB2, and PB0, PB1…PB26, PB27 according to HDMI specs in the software.
2. When calculating the checksum value (PB0), the ECC values are ignored.
3. Refer to section 5.2.3.4 and 5.2.3.5 of the HDMI 1.4 Specification [Ref 13] for more information on the Aux packet structure.

In Table 2-1, the packet types highlighted in blue are handled by hardware and the packet types highlighted in yellow are handled by software.
Table 2-1: Hardware and Software Packet Types (Cont’d)

<table>
<thead>
<tr>
<th>Packet Type Value</th>
<th>Packet Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x09</td>
<td>High Bitrate (HBR) Audio Stream Packet (IEC 61937)</td>
</tr>
<tr>
<td>0x0A</td>
<td>Gamut Metadata Packet</td>
</tr>
<tr>
<td>0x80+</td>
<td>InfoFrame Packet</td>
</tr>
<tr>
<td>0x00</td>
<td>Reserved</td>
</tr>
<tr>
<td>0x01</td>
<td>Vendor-Specific</td>
</tr>
<tr>
<td>0x02</td>
<td>Auxiliary Video Information (AVI)</td>
</tr>
<tr>
<td>0x03</td>
<td>Source Product Descriptor</td>
</tr>
<tr>
<td>0x04</td>
<td>Audio</td>
</tr>
<tr>
<td>0x05</td>
<td>MPEG Source</td>
</tr>
<tr>
<td>0x06</td>
<td>NTSC VBI</td>
</tr>
<tr>
<td>0x07</td>
<td>Dynamic Range and Mastering (HDR)</td>
</tr>
</tbody>
</table>

In the HDMI TX Subsystem driver, a common API is defined for sending auxiliary packets.

```c
void XV_HdmiTxSs_SendGenericAuxInfoframe(XV_HdmiTxSs *InstancePtr, void *Aux)
```

where,

- InstancePtr is a pointer to HDMI TX Subsystem instance.
- Aux is a 36 byte array contains the complete AUX packet.

A common aux packet data structure defined in the driver.

```c
typedef union {
    u32 Data;
    u8 Byte[4];
} XHdmiC_AuxHeader;

typedef union {
    u32 Data[8];
    u8 Byte[32];
} XHdmiC_AuxData;

typedef struct {
    XHdmiC_AuxHeader Header;
    XHdmiC_AuxData Data;
} XHdmiC_Aux;
```

For packet types not highlighted in Figure 2-1 (HDR, HLG), you may construct packets with respect to the specification, and send them using the same API call. In this case, you must calculate the CRC whenever needed and place the CRC at the right location so that the HDMI Sink can decode the packet.
InfoFrames

As shown in Figure 2-1, software handles AVI InfoFrame, Audio InfoFrame and Vendor Specific InfoFrame (VSIF). The three InfoFrames types are added as part of the HDMI Transmitter Subsystem data structure, each having its own well-defined structure.

AVI InfoFrame

Use the following code example for AVI InfoFrames:

```c
typedef struct XHDMIC_AVI_InfoFrame {
    unsigned char Version;
    XHdmiC_Colorspace ColorSpace;
    u8 ActiveFormatDataPresent;
    XHdmiC_BarInfo BarInfo;
    XHdmiC_ScanInfo ScanInfo;
    XHdmiC_Colorimetry Colorimetry;
    XHdmiC_PicAspectRatio PicAspectRatio;
    unsigned char Itc;
    XHdmiC_ExtendedColorimetry ExtendedColorimetry;
    XHdmiC_RGBQuantizationRange QuantizationRange;
    XHdmiC_NonUniformPictureScaling NonUniformPictureScaling;
    unsigned char VIC;
    XHdmiC_YccQuantizationRange YccQuantizationRange;
    XHdmiC_ContentType ContentType;
    XHdmiC_PixelRepetitionFactor PixelRepetition;
    u16 TopBar;
    u16 BottomBar;
    u16 LeftBar;
    u16 RightBar;
} XHdmiC_AVI_InfoFrame;
```

Audio InfoFrame

Use the following code example for Audio InfoFrames:

```c
typedef struct XHdmiC_Audio_InfoFrame {
    unsigned char Version;
    XHdmiC_AudioChannelCount ChannelCount;
    XHdmiC_AudioCodingType CodingType;
    XHdmiC_SampleSize SampleSize;
    XHdmiC_SamplingFrequency SampleFrequency;
    u8 CodingTypeExt;
    u8 ChannelAllocation;
    XHdmiC_LFEPlaybackLevel LFE_Playback_Level;
    XHdmiC_LevelShiftValue LevelShiftVal;
    unsigned char Downmix_Inhibit;
} XHdmiC_AudioInfoFrame;
```

Vendor Specific InfoFrame (VSIF)

Use the following code example for VSIF:

```c
typedef struct {
```
u8 Version;
uint IEEE_ID;
XHdmiC_VSIF_Video_Format Format;

union {
    u8 HDMI_VIC;
    XHdmiC_3D_Info Info_3D;
} } XHdmiC_VSIF;

The following API functions are defined in HDMI Common driver to facilitate the construction of the InfoFrame packets. You must set the corresponding fields in the data structure and use the call functions below based on InfoFrame type. The API function constructs the packet and simultaneously calculates CRC for both packet header and packet body.

XHdmiC_Aux XV_HdmiC_AVIIF_GeneratePacket(XHdmiC_AVI_InfoFrame *infoFramePtr);
XHdmiC_Aux XV_HdmiC_AudioIF_GeneratePacket(XHdmiC_AudioInfoFrame *AudioInfoFrame);
XHdmiC_Aux XV_HdmiC_VSIF_GeneratePacket(XHdmiC_VSIF *VSIFPtr);

General Control Packet

General Control Packet is automatically generated by HDMI Transmitter Subsystem according to the video stream and sent out within 384 clocks after vsync. Four API functions are defined to set or clear the AVMUTE field as per their system application requirement.

void XV_HdmiTxSs_SetGcpAvmuteBit(XV_HdmiTxSs *InstancePtr);
void XV_HdmiTxSs_ClearGcpAvmuteBit(XV_HdmiTxSs *InstancePtr);

HDCP

As part of the HDMI TX Subsystem, the Xilinx® LogiCORE™ IP High-bandwidth Digital Content Protection (HDCP™) transmitters are designed for transmission of audiovisual content securely between two devices that are HDCP capable. In this HDMI TX Subsystem, both HDCP 1.4 and HDCP 2.2 Transmitter IP cores are included. However because HDCP 2.2 supersedes the HDCP 1.4 protocol and does not provide backwards compatibility, you need to decide and choose targeted content protection schemes from the Vivado IDE. Four different options are available to choose from:

- No HDCP
- HDCP 1.4 only
- HDCP 2.2 only
- HDCP 1.4 and HDCP 2.2

As a guideline, HDCP 2.2 is used to encrypt content at Ultra-High Definition (UHD) while HDCP 1.4 is the legacy content protection scheme used at lower resolutions.

Figure 2-6 shows a configuration of the HDMI transmitter where both HDCP 1.4 and 2.2 are enabled. With both HDCP protocols enabled, the HDMI Subsystem configures itself in the
cascade topology where the HDCP 1.4 and HDCP 2.2 are connected back-to-back. The HDCP Egress interface of the HDMI transmitter sends unencrypted audiovisual data, which is encrypted by the active HDCP block and sent back into the HDMI transmitter over the HDCP Ingress interface for transmission over the link. The HDMI TX Subsystem ensures that only one of the HDCP protocols is active at any given time and the other is passive by calling the relevant HDMI TX Subsystem API functions.

For more details on HDCP, see the HDCP v1.4 Product Guide (PG224) [Ref 26] and HDCP v2.2 Product Guide (PG249) [Ref 25].

### Standards

The HDMI 1.4/2.0 Transmitter Subsystem is compliant with the AXI4-Stream Video Protocol and AXI4-Lite interconnect standards. See the Vivado AXI Reference Guide (UG1037) [Ref 1] and AXI4-Stream Video IP and System Design Guide (UG934) [Ref 15] for additional information. Also, see HDMI specifications [Ref 13].

The HDMI TX Subsystem is compliant with the HDMI 1.4b and HDMI 2.0 specification [Ref 13].

The Xilinx HDCP 1.4 is designed to be compatible with High-bandwidth Digital Content Protection system Revision 1.4 [Ref 14].

The Xilinx HDCP 2.2 is compliant with the HDCP 2.2 specification entitled High-bandwidth Digital Content Protection, Mapping HDCP to HDMI, Revision 2.2, issued by Digital Content Protection (DCP) LLC [Ref 14].
Performance and Resource Utilization

For full details about performance and resource utilization, visit the Performance and Resource Utilization web page.

Maximum Frequencies

Refer to the following documents for information on DC and AC switching characteristics. The frequency ranges specified in these documents must be adhered to for proper transceiver and core operation.

- Kintex UltraScale FPGAs Data Sheet: DC and AC Switching Characteristics (DS892) [Ref 2]
- Virtex UltraScale FPGAs Data Sheet: DC and AC Switching Characteristics (DS893) [Ref 3]
- Kintex-7 FPGAs Data Sheet: DC and AC Switching Characteristics (DS182) [Ref 4]
- Virtex-7 FPGAs Data Sheet: DC and AC Switching Characteristics (DS183) [Ref 5]
- Artix-7 FPGAs Data Sheet: DC and AC Switching Characteristics (DS181) [Ref 6]
- Zynq-7000 SoC: DC and AC Switching Characteristics (DS187) [Ref 7]
- Zynq-7000 SoC: DC and AC Switching Characteristics (DS191) [Ref 8]
- Kintex UltraScale+ FPGAs Data Sheet: DC and AC Switching Characteristics (DS922) [Ref 9]
- Virtex UltraScale+ FPGAs Data Sheet: DC and AC Switching Characteristics (DS923) [Ref 10]
- Zynq UltraScale+ MPSoC Data Sheet: DC and AC Switching Characteristics (DS925) [Ref 11]
- Zynq UltraScale+ RFSoC Data Sheet: DC and AC Switching Characteristics (DS926) [Ref 12]

Port Descriptions

Figure 2-7 to Figure 2-10 show the HDMI 1.4/2.0 Transmitter Subsystem ports when AXI4-Stream is selected as video interface. The VIDEO_IN port is expanded in the figure to show the detail AXI4-Stream Video bus signals.

The following subsystem has three default interfaces:

- AXI4-Lite control interface (S_AXI_CPU_IN)
Chapter 2: Product Specification

- Video Interface (VIDEO_IN)
- Audio Interface (AUDIO_IN)

where

\[
\text{video\_data\_width} = (\text{int}((3\times\text{BPC}\times\text{PPC}+7)/8))\times8
\]
Figure 2-8: HDMI TX Subsystem Pinout – AXI4-Stream Video Interface (HDCP 1.4 Only)
Figure 2-9: HDMI TX Subsystem Pinout – AXI4-Stream Video Interface (HDCP 2.2 Only)
Chapter 2: Product Specification

Figure 2-10: HDMI TX Subsystem Pinout – AXI4-Stream Video Interface (HDCP 1.4 and HDCP 2.2)

Figure 2-11 to Figure 2-14 show the HDMI 1.4/2.0 Transmitter Subsystem ports when Native Video is selected as video interface. The VIDEO_IN port is expanded in the figure to show the detail Native Video bus signals.
Figure 2-11: HDMI TX Subsystem Pinout – Native Video Interface (No HDCP)
Figure 2-12: HDMI TX Subsystem Pinout – Native Video Interface (HDCP 1.4 Only)
Figure 2-13: HDMI TX Subsystem Pinout – Native Video Interface (HDCP 2.2 Only)
Figure 2-14: HDMI TX Subsystem Pinout – Native Video Interface (HDCP 1.4 and HDCP 2.2)
CPU Interface

Table 2-2 shows the AXI4-Lite control interface signals. This interface is an AXI4-Lite interface and runs at the s_axi_cpu_aclk clock rate. Control of the subsystem is only supported through the subsystem driver.

**IMPORTANT:** The direct register level access to any of the submodules is not supported. Instead, all the accesses are done through driver APIs.

**Table 2-2: CPU Interface Ports**

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Width</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>s_axi_cpu_arsetn</td>
<td>Input</td>
<td>1</td>
<td>Reset (Active-Low)</td>
</tr>
<tr>
<td>s_axi_cpu_aclk</td>
<td>Input</td>
<td>1</td>
<td>Clock for AXI4-Lite control interface</td>
</tr>
<tr>
<td>S_AXI_CPU_IN_awaddr</td>
<td>Input</td>
<td>17</td>
<td>Write address</td>
</tr>
<tr>
<td>S_AXI_CPU_IN_awprot</td>
<td>Input</td>
<td>3</td>
<td>Write address protection</td>
</tr>
<tr>
<td>S_AXI_CPU_IN_awvalid</td>
<td>Input</td>
<td>1</td>
<td>Write address valid</td>
</tr>
<tr>
<td>S_AXI_CPU_IN_awready</td>
<td>Output</td>
<td>1</td>
<td>Write address ready</td>
</tr>
<tr>
<td>S_AXI_CPU_IN_wdata</td>
<td>Input</td>
<td>32</td>
<td>Write data</td>
</tr>
<tr>
<td>S_AXI_CPU_IN_wstrb</td>
<td>Input</td>
<td>4</td>
<td>Write data strobe</td>
</tr>
<tr>
<td>S_AXI_CPU_IN_wvalid</td>
<td>Input</td>
<td>1</td>
<td>Write data valid</td>
</tr>
<tr>
<td>S_AXI_CPU_IN_wready</td>
<td>Output</td>
<td>1</td>
<td>Write data ready</td>
</tr>
<tr>
<td>S_AXI_CPU_IN_bresp</td>
<td>Output</td>
<td>2</td>
<td>Write response</td>
</tr>
<tr>
<td>S_AXI_CPU_IN_bvalid</td>
<td>Output</td>
<td>1</td>
<td>Write response valid</td>
</tr>
<tr>
<td>S_AXI_CPU_IN_bready</td>
<td>Input</td>
<td>1</td>
<td>Write response ready</td>
</tr>
<tr>
<td>S_AXI_CPU_IN_araddr</td>
<td>Input</td>
<td>17</td>
<td>Read address</td>
</tr>
<tr>
<td>S_AXI_CPU_IN_arprot</td>
<td>Input</td>
<td>3</td>
<td>Read address protection</td>
</tr>
<tr>
<td>S_AXI_CPU_IN_arvalid</td>
<td>Input</td>
<td>1</td>
<td>Read address valid</td>
</tr>
<tr>
<td>S_AXI_CPU_IN_aready</td>
<td>Output</td>
<td>1</td>
<td>Read address ready</td>
</tr>
<tr>
<td>S_AXI_CPU_IN_rdata</td>
<td>Output</td>
<td>32</td>
<td>Read data</td>
</tr>
<tr>
<td>S_AXI_CPU_IN_rresp</td>
<td>Output</td>
<td>2</td>
<td>Read data response</td>
</tr>
<tr>
<td>S_AXI_CPU_IN_rvalid</td>
<td>Output</td>
<td>1</td>
<td>Read data valid</td>
</tr>
<tr>
<td>S_AXI_CPU_IN_rready</td>
<td>Input</td>
<td>1</td>
<td>Read data ready</td>
</tr>
</tbody>
</table>
Chapter 2: Product Specification

Video Input Stream Interface

This HDMI 1.4/2.0 Transmitter Subsystem is supporting two types of video input stream interfaces, which eventually is mapped to HDMI 1.4/2.0 Transmitter Subsystem VIDEO_IN interface.

- AXI4-Stream Video interface
- Native Video Interface

Table 2-3 shows the signals for AXI4-Stream video input streaming interface. This interface is an AXI4-Stream slave interface and runs at the $s_{\text{axis}}$ video $aclk$ clock rate. The data width is user-configurable in the Vivado IDE by setting Max Bits Per Component (BPC) and Number of Pixels Per Clock on Video Interface (PPC).

### Table 2-3: Video Input Stream Interface

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Width</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$s_{\text{axis}}$ video $aclk$</td>
<td>Input</td>
<td>1</td>
<td>AXI4-Stream clock</td>
</tr>
<tr>
<td>$s_{\text{axis}}$ video $aresetn$</td>
<td>Input</td>
<td>1</td>
<td>Reset (Active-Low)</td>
</tr>
<tr>
<td>VIDEO_IN_tdata</td>
<td>Input</td>
<td>$(3\times BPC \times PPC + 7)/8$</td>
<td>Data</td>
</tr>
<tr>
<td>VIDEO_IN_tlast</td>
<td>Input</td>
<td>1</td>
<td>End of line</td>
</tr>
<tr>
<td>VIDEO_IN_tready</td>
<td>Output</td>
<td>1</td>
<td>Ready</td>
</tr>
<tr>
<td>VIDEO_IN_tuser</td>
<td>Input</td>
<td>1</td>
<td>Start of frame</td>
</tr>
<tr>
<td>VIDEO_IN_tvalid</td>
<td>Input</td>
<td>1</td>
<td>Valid</td>
</tr>
</tbody>
</table>

**Notes:**
1. The Video Data width for AXI4-Stream interface is byte aligned. For example, for 10 bpc, 2 ppc, the data width is 64 bits.

Native Video Input Interface

Table 2-4 shows the signals for Native video input interface. This interface is a standard video interface and runs at $\text{video clk}$ clock rate. The data width is user-configurable in the Vivado IDE by setting Max Bits Per Component (BPC) and Number of Pixels Per Clock on Video Interface (PPC).

### Table 2-4: Native Video Input Interface

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Width</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\text{video clk}$</td>
<td>Input</td>
<td>1</td>
<td>Video clock</td>
</tr>
<tr>
<td>VIDEO_IN_active_video</td>
<td>Input</td>
<td>1</td>
<td>Active video</td>
</tr>
<tr>
<td>VIDEO_IN_data</td>
<td>Input</td>
<td>$3 \times BPC \times PPC$</td>
<td>Data</td>
</tr>
<tr>
<td>VIDEO_IN_hsync</td>
<td>Input</td>
<td>1</td>
<td>Horizontal sync</td>
</tr>
</tbody>
</table>
Chapter 2: Product Specification

Audio Input Stream Interface

Table 2-5 shows the signals for AXI4-Stream audio input streaming interfaces. The audio interface transports 24-bits L-PCM or 16-bits HBR audio samples in the IEC 60958 format. A maximum of eight channels are supported. The audio interface is a 32-bit AXI4-Stream slave interface and runs at the \( \text{s_axis_audio_aclk} \) clock rate.

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Width</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \text{s_axis_audio_aclk} )</td>
<td>Input</td>
<td>1</td>
<td>Clock (The audio streaming clock must be greater than or equal to 128 times</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>the audio sample frequency)</td>
</tr>
<tr>
<td>( \text{s_axis_audio_aresetn} )</td>
<td>Input</td>
<td>1</td>
<td>Reset (Active-Low)</td>
</tr>
<tr>
<td>( \text{AUDIO_IN_tdata} )</td>
<td>Input</td>
<td>32</td>
<td>Data</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[31] P (Parity)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[30] C (Channel status)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[29] U (User bit)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[28] V (Validity bit)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[27:4] Audio sample word</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>[3:0] Preamble code</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4'b0001 Subframe 1/start of audio block</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4'b0010 Subframe 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4'b0011 Subframe 2</td>
</tr>
<tr>
<td>( \text{AUDIO_IN_tid} )</td>
<td>Input</td>
<td>3</td>
<td>Channel ID</td>
</tr>
<tr>
<td>( \text{AUDIO_IN_tready} )</td>
<td>Output</td>
<td>1</td>
<td>Ready</td>
</tr>
<tr>
<td>( \text{AUDIO_IN_tvalid} )</td>
<td>Input</td>
<td>1</td>
<td>Valid</td>
</tr>
</tbody>
</table>

Notes:
1. When native video interface is selected, \( \text{s_axis_video_aclk} \) and \( \text{s_axis_video_aresetn} \) are removed from the HDMI 1.4/2.0 Transmitter Subsystem interface ports.
2. \( \text{video_clk} \) is generated by Video PHY Controller LogiCORE IP Product Guide (PG230) [Ref 24].
3. When native video interface is selected, there is no hardware reset.
4. You must provide the correct video timing information. You can choose to use Xilinx Video Timing Controller (vtc) or design your own vtc module to generate the timing control signals for native video interface.

Audio Clock Regeneration Interface

The audio clock regeneration (ACR) interface has a Cycle Time Stamp (CTS) parameter vector and an Audio Clock Regeneration Value (N) parameter vector. Both vectors are 20
bits wide. The valid signal is driven High when the CTS and N parameters are stable. For more information, see Chapter 7 of the HDMI 1.4 specification [Ref 13].

On the rising edge of the valid signal, the TX reads the CTS and N parameters from the ACR input interface and transmits an audio clock regeneration packet.

Table 2-6 shows the Audio Clock Regeneration (ACR) interface signals. This interface runs at the s_axis_audio_aclk clock rate.

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Width</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>acr_cts</td>
<td>Input</td>
<td>20</td>
<td>CTS</td>
</tr>
<tr>
<td>acr_n</td>
<td>Input</td>
<td>20</td>
<td>N</td>
</tr>
<tr>
<td>acr_valid</td>
<td>Input</td>
<td>1</td>
<td>Valid</td>
</tr>
</tbody>
</table>

If a HDMI system does not require audio, tie the following input ports to LOW:

- AUDIO_IN (except tready)
- s_axis_audio_aresetn
- s_axis_audio_aclk
- acr_cts
- acr_n
- acr_valid

**IMPORTANT:** When multiple channel audio is enabled in the system, ensure that the audio data is properly sent to their perspective channel allocation. Unused channels must be packed with zero (i.e. Mute) to avoid audio channel swapping, which means audio data may appear in unexpected channel locations.

**Note:** The L-PCM (Packet Type 0x02) allows you to pack up to 24 bits of audio from the Audio Data Stream. The HBR (Packet Type 0x09) allows you to pack up to 16 bits of audio from the Audio Data Stream. The data is taken from MSB (bit 27:12). Compressed Audio (IEC 61937) can also be sent the same as L-PCM data (IEC60958). However, it is your responsibility to compress the audio data and uncompress the data audio with your custom logic.

**IMPORTANT:** L-PCM (IEC60958) Audio is the only Audio format tested on board in Example Design by Xilinx.

**HDMI Link Output Interface**

Table 2-7 shows the HDMI Link Output interface signals. This interface runs at the link_clk clock rate.
Chapter 2: Product Specification

Data Display Channel Interface

Table 2-8 shows the Data Display Channel interface signals.

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Width</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>link_clk</td>
<td>Input</td>
<td>1</td>
<td>Link clock</td>
</tr>
<tr>
<td>LINK_DATA0_OUT_tdata</td>
<td>Output</td>
<td>ppc*10</td>
<td>Link data 0</td>
</tr>
<tr>
<td>LINK_DATA0_OUT_tvalid</td>
<td>Output</td>
<td>1</td>
<td>Link Data 0 Valid</td>
</tr>
<tr>
<td>LINK_DATA1_OUT_tdata</td>
<td>Output</td>
<td>ppc*10</td>
<td>Link data 1</td>
</tr>
<tr>
<td>LINK_DATA1_OUT_tvalid</td>
<td>Output</td>
<td>1</td>
<td>Link Data 1 Valid</td>
</tr>
<tr>
<td>LINK_DATA2_OUT_tdata</td>
<td>Output</td>
<td>ppc*10</td>
<td>Link data 2</td>
</tr>
<tr>
<td>LINK_DATA2_OUT_tvalid</td>
<td>Output</td>
<td>1</td>
<td>Link Data 2 Valid</td>
</tr>
</tbody>
</table>

HDCP 1.4 Key Input Interface (AXI4-Stream Slave Interface)

Table 2-9 shows the signals for HDCP 1.4 key interface. This interface runs at the hdcp14_key_aclk (which is running at AXI4 Lite Clock).

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Width</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDCP_KEY_IN_tdata</td>
<td>Input</td>
<td>64</td>
<td>HDCP 1.4 key data</td>
</tr>
<tr>
<td>HDCP_KEY_IN_tlast</td>
<td>Input</td>
<td>1</td>
<td>End of key data</td>
</tr>
<tr>
<td>HDCP_KEY_IN_tready</td>
<td>Output</td>
<td>1</td>
<td>Ready</td>
</tr>
<tr>
<td>HDCP_KEY_IN_tuser</td>
<td>Input</td>
<td>8</td>
<td>Start of key data</td>
</tr>
<tr>
<td>HDCP_KEY_IN_tvalid</td>
<td>Input</td>
<td>1</td>
<td>Valid</td>
</tr>
<tr>
<td>hdcp14_key_aclk</td>
<td>Output</td>
<td>1</td>
<td>AXI4-Stream clock</td>
</tr>
<tr>
<td>hdcp14_keyaresetn</td>
<td>Output</td>
<td>1</td>
<td>Reset (Active-Low)</td>
</tr>
<tr>
<td>hdcp14_start_key_transmit</td>
<td>Output</td>
<td>1</td>
<td>Start key transmit</td>
</tr>
<tr>
<td>hdcp14_reg_key_sel</td>
<td>Output</td>
<td>3</td>
<td>Key select</td>
</tr>
</tbody>
</table>
For the HDCP 1.4 transmitter, an HDCP Key Management module is needed, which is able to send keys over the AXI4-Stream interface to the HDCP 1.4 controller. Figure 2-15 shows an example of how the HDMI TX Subsystem is connected to the HDCP Key Management module through a Key Management Bus (AXI4-Stream). The HDCP Key Management module is not part of the HDMI TX Subsystem. For HDCP 1.4 design details, see the *HDCP v1.4 Product Guide* (PG224) [Ref 26].

![Figure 2-15: HDCP 1.4 Key Management Bus (AXI4-Stream)](image)

However, the HDCP 2.2 key is handled slightly differently as it is solely controlled by the software application. The user application is responsible for providing the infrastructure to securely store and retrieve the keys to be loaded into the HDCP 2.2 drivers. For the detailed list of keys that are required to be loaded by the user application, see the *HDCP v2.2 Product Guide* (PG249) [Ref 25].

**HDCP 2.2 Interrupt Outputs**

*Table 2-10* shows the signals for HDCP 2.2 interrupt output ports.

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Width</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hdcp22_irq</td>
<td>Output</td>
<td>1</td>
<td>HDCP 2.2 interrupt</td>
</tr>
<tr>
<td>hdcp22_timer_irq</td>
<td>Output</td>
<td>1</td>
<td>HDCP 2.2 timer interrupt</td>
</tr>
</tbody>
</table>
Chapter 2: Product Specification

Miscellaneous Signals with AXI4-Stream Video Interface

Table 2-11 shows the miscellaneous signals with AXI4-Stream video interface selected.

Table 2-11: Miscellaneous Signals with AXI4-Stream Video Interface

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Width</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hpd</td>
<td>Input</td>
<td>1</td>
<td>If XGUI option: Hot Plug Detect Active High (Default)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0 - Hot Plug Detect is released</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 - Hot Plug Detect is asserted</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>If XGUI option: Hot Plug Detect Active Low (1)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0 - Hot Plug Detect is asserted</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 - Hot Plug Detect is released</td>
</tr>
<tr>
<td>locked</td>
<td>Output</td>
<td>1</td>
<td>Flag indicating the subsystem is locked to the incoming video stream.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0 - no lock</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 - locked</td>
</tr>
<tr>
<td>irq</td>
<td>Output</td>
<td>1</td>
<td>Interrupt request for CPU. Active-High.</td>
</tr>
<tr>
<td>video_clk</td>
<td>Input</td>
<td>1</td>
<td>Reference Native Video Clock</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>When AXI4-Stream is selected as Video Interface, an AXI4-Stream to Video Out</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Bridge module is added to the HDMI TX Subsystem to convert AXI4-Stream Video</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>into Native Video. HDMI TX core uses this video_clk to clock in the Video</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Data.</td>
</tr>
<tr>
<td>SB_STATUS_IN_tdata</td>
<td>Input</td>
<td>2</td>
<td>Side Band Status input signals</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Bit 0: link_rdy</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Bit 1: video_rdy</td>
</tr>
<tr>
<td>SB_STATUS_IN_tvalid</td>
<td>Input</td>
<td>1</td>
<td>Side Band Status input valid</td>
</tr>
<tr>
<td>fid</td>
<td>Input</td>
<td>1</td>
<td>Field ID for AXI4-Stream bus. Used only for interlaced video.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0 - even field</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 - odd field</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>This bit is sampled coincident with the SOF on the AXI4-Stream bus. If the</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>signal is not used, set the input to Low.</td>
</tr>
</tbody>
</table>

1. The Hot Plug Detect (HPD) signal is driven by an HDMI sink and asserted when the HDMI cable is connected to notify the HDMI source of the presence of an HDMI sink. In some cases, the HDMI sink is simply connected to 5V power signal. Therefore, in the PCB, if you choose to use a voltage divider or level shifter, the HPD polarity remains as Active High. However, if you add an inverter to the HPD signal, then the HPD polarity must be set to Active Low in HDMI Transmitter Subsystem GUI.
**Miscellaneous Signals with Native Video Interface**

Table 2-12 shows the miscellaneous signals with native video interface selected.

**Table 2-12: Miscellaneous Signals with Native Video Interface**

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Width</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>hpd</td>
<td>Input</td>
<td>1</td>
<td>If XGUI option: Hot Plug Detect Active High (Default)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0 - Hot Plug Detect is released</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 - Hot Plug Detect is asserted</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>If XGUI option: Hot Plug Detect Active Low (1)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0 - Hot Plug Detect is asserted</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1 - Hot Plug Detect is released</td>
</tr>
<tr>
<td>irq</td>
<td>Output</td>
<td>1</td>
<td>Interrupt request for CPU. Active-High.</td>
</tr>
<tr>
<td>SB_STATUS_IN_tdata</td>
<td>Input</td>
<td>2</td>
<td>Side Band Status input signals</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Bit 0: link_rdy</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Bit 1: video_rdy</td>
</tr>
<tr>
<td>SB_STATUS_IN_tvalid</td>
<td>Input</td>
<td>1</td>
<td>Side Band Status input valid</td>
</tr>
<tr>
<td>video_rst</td>
<td>Output</td>
<td>1</td>
<td>Video reset signal in video_clk domain. Active-High.</td>
</tr>
</tbody>
</table>

1. The Hot Plug Detect (HPD) signal is driven by an HDMI sink and asserted when the HDMI cable is connected to notify the HDMI source of the presence of an HDMI sink. In most cases, the HDMI sink is simply connected to 5V power signal. Therefore, in the PCB, if you choose to use a voltage divider or level shifter, the HPD polarity remains as Active High. However, if you add an inverter to the HPD signal, then the HPD polarity must be set to Active Low in HDMI Transmitter Subsystem GUI.
Clocks and Resets

Table 2-13 provides an overview of the clocks and resets. See Clocking and Resets in Chapter 3 for more information.

Table 2-13: Clocks and Resets

<table>
<thead>
<tr>
<th>Name</th>
<th>Direction</th>
<th>Width</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>s_axi_cpu_aclk</td>
<td>Input</td>
<td>1</td>
<td>AXI4-Lite CPU control interface clock.</td>
</tr>
<tr>
<td>s_axi_cpu_aresetn</td>
<td>Input</td>
<td>1</td>
<td>Reset, associated with s_axi_cpu_aclk (active-Low). The s_axi_cpu_aresetn signal resets the entire subsystem including the data path and AXI4-Lite registers.</td>
</tr>
<tr>
<td>s_axis_video_aclk</td>
<td>Input</td>
<td>1</td>
<td>AXI4-Stream video input clock.</td>
</tr>
<tr>
<td>s_axis_video_aresetn</td>
<td>Input</td>
<td>1</td>
<td>Reset, associated with s_axis_video_aclk (active-Low). Resets the AXI4-Stream data path for the video input.</td>
</tr>
<tr>
<td>s_axis_audio_aclk</td>
<td>Input</td>
<td>1</td>
<td>AXI4-Stream Audio input clock. (The audio streaming clock must be greater than or equal to 128 times the audio sample frequency)</td>
</tr>
<tr>
<td>s_axis_audio_aresetn</td>
<td>Input</td>
<td>1</td>
<td>Reset, associated with s_axis_audio_aclk (active-Low). Resets the AXI4-Stream data path for the audio input.</td>
</tr>
<tr>
<td>link_clk</td>
<td>Input</td>
<td>1</td>
<td>HDMI Link data output clock. This connects to the Video PHY Controller Link clock output.</td>
</tr>
<tr>
<td>video_clk</td>
<td>Input</td>
<td>1</td>
<td>Clock for the native video interface.</td>
</tr>
</tbody>
</table>

Notes:
1. The reset should be asserted until the associated clock becomes stable.
Designing with the Subsystem

This chapter includes guidelines and additional information to facilitate designing with the subsystem.

General Design Guidelines

The subsystem connects to other hardware components to construct a complete HDMI TX system. These hardware components usually are different from device to device. For example, Kintex®-7 devices have a different PLL architecture from UltraScale™ devices. Therefore, you need to fully understand the system and adjust the subsystem parameters accordingly. Appendix D, Application Software Development describes how to integrate the subsystem API into a software application.

Audio Data Stream

An AXI4-Stream audio cycle is illustrated in Figure 3-1. The data is captured when both the valid (TVLD) and ready (TRDY) signals are asserted. The HDMI 1.4/2.0 Transmitter Subsystem expects the channels in sequential order. If the channel data is not in order, the channel data might be mapped into other channel sample slots. Therefore, ensure that the audio stream source sends out adjacent channels in sequential order (CH0, CH1, etc).

In HDMI 1.4/2.0 Transmitter Subsystem, the audio information, such as format and number of channels, are extracted from the video stream. This information is available through API calls.

- XV_HdmiTxSs_SetAudioFormat
- XV_HdmiRxSs_GetAudioChannels
The actual audio data is extracted and sent to \texttt{AUDIO\_OUT} interface. Similarly, the ACR values are extracted from the ACR packets and sent to ACR ports.

\textbf{IMPORTANT:} \textit{When multiple channel audio is enabled in the system, ensure that the audio data is properly sent to their perspective channel allocation. Unused channels must be packed with zero (i.e. Mute) to avoid audio channel swapping, which means audio data may appear in unexpected channel locations.}

In HDMI TX Subsystem, L-PCM (IEC 60958, Packet Type 0x02) and HBR (Packet Type 0x09) are handled by the hardware. An API function is available that allows for the setting of the audio format, and the hardware packs the audio based on the Audio Format selected.

\begin{verbatim}
void XV_HdmiTxSs_SetAudioFormat(XV_HdmiTxSs *InstancePtr, u8 format);
\end{verbatim}

where:

- `InstancePtr` is a pointer to `XV_HdmiTxSs` instance
- `format` is a selector of Audio Format
  - 1:HBR
  - 0:L-PCM

\textbf{Video Input Stream Interface}

The AXI4-Stream video interface supports dual or quad pixels per clock with 8 bits, 10 bits, 12 bits and 16 bits per component for RGB, YUV444, and YUV420 color spaces. The color depth in YUV422 color space is always 12-bits per pixel.

When the parameter, \textbf{Max Bits Per Component}, is set to 16, Figure 3-2 shows the data format for quad pixels per clock to be fully compliant with the AXI4-Stream video protocol. A data format for a fully compliant AXI4-Stream video protocol dual pixels per clock is illustrated in Figure 3-3.
Chapter 3: Designing with the Subsystem

When the parameter, Max Bits Per Component, is set to 12, video formats with actual bits per component larger than 12 is truncated to the Max Bits Per Component. The remaining least significant bits are discarded. If the actual bits per component is smaller than Max Bits Per Component set in the Vivado IDE, all bits are transported with the MSB aligned and the remaining LSB bits are padded with 0. This applies to all Max Bits Per Component settings.

Figure 3-2: Quad Pixels Data Format (Max Bits Per Component = 16)

Figure 3-3: Dual Pixels Data Format (Max Bits Per Component = 16)
Table 3-1: Max Bits Per Component Support

<table>
<thead>
<tr>
<th>Max Bits Per Component</th>
<th>Actual Bits Per Component</th>
<th>Bits Transported by Hardware</th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>[7:0]</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>[9:0]</td>
</tr>
<tr>
<td></td>
<td>12</td>
<td>[11:0]</td>
</tr>
<tr>
<td></td>
<td>16</td>
<td>[15:0]</td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>[7:0]</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>[9:0]</td>
</tr>
<tr>
<td></td>
<td>12</td>
<td>[11:0]</td>
</tr>
<tr>
<td></td>
<td>16</td>
<td>[15:4]</td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>[7:0]</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>[9:0]</td>
</tr>
<tr>
<td></td>
<td>12</td>
<td>[11:2]</td>
</tr>
<tr>
<td></td>
<td>16</td>
<td>[15:6]</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>[7:0]</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>[9:2]</td>
</tr>
<tr>
<td></td>
<td>16</td>
<td>[15:8]</td>
</tr>
</tbody>
</table>

As an illustration, when Max Bits Per Component is set to 12, Figure 3-4 shows the data format for quad pixels per clock to be fully compliant with the AXI4-Stream video protocol. A data format for a fully compliant AXI4-Stream video protocol with dual pixels per clock is illustrated in Figure 3-5.
Chapter 3: Designing with the Subsystem

The video interface can also transport quad and dual pixels in the YUV420 color space. Figure 3-6 and Figure 3-7 show the data format for quad and dual pixels formats.

Figure 3-6: YUV420 Color Space Quad Pixels Data Format
Similarly, for YUV 4:2:0 deep color (10, 12, or 16 bits), the data representation is the same as shown in Figure 3-6 and Figure 3-7. The only difference is that each component carries more bits (10, 12, and 16). However the current data format is not complaint with the AXI4-Stream video protocol. Therefore, a remapping feature is added to HDMI 1.4/2.0 Receiver Subsystem to convert HDMI native video into AXI4-Stream video. This feature can be enabled from the HDMI Receiver Subsystem GUI. To illustrate how the data remapping feature works for YUV 4:2:0 video from Native Video into AXI4-Stream, Figure 3-7 is extended to Figure 3-8 to represent native video data associated with the clock and control signals. When transporting using AXI4-Stream, the data representation need to be compliant to the protocol defined in the AXI4-Stream Video IP and System Design Guide (UG934) [Ref 15]. With the remapping feature, the same native video data is converted into AXI4-Stream formats, shown in Figure 3-9. As stated in AXI4-Stream Video IP and System Design Guide (UG934) [Ref 15], the 4:2:0 format adds vertical subsampling to the 4:2:2 format, which is implemented in Video over AXI4-Stream by omitting the chroma data on every other line.
Chapter 3: Designing with the Subsystem

Note: For RGB/YUV444/YUV422 formats, video data is directly mapped from AXI4-Stream to Native Video interface without any line buffer. Therefore, Figure 3-2 to Figure 3-5 represent the data interface for both AXI4 Stream and Native Video. The control signals are omitted in the figures.

The subsystem provides full flexibility to construct a system using the configuration parameters, maximum bits per component and number of pixels per clock. Set these parameters so that the video clock and link clock are supported by the targeted device. For example, when dual pixels per clock is selected, the AXI4-Stream video need to run at higher clock rate comparing with quad pixels per clock design. In this case, it is more difficult for the system to meeting timing requirements. Therefore the quad pixels per clock data mapping is recommended for design intended to send higher video resolutions, for example, 4kp60 video.

Some video resolutions (for example, 720p60) have horizontal timing parameters (1650) which are not a multiple of 4. In this case the dual pixels per clock data mapping must be chosen.

For more information on the video AXI4-Stream interface and video data format, see the AXI4-Stream Video IP and System Design Guide (UG934) [Ref 15].
Interlaced Video

The HDMI 1.4/2.0 Transmitter Subsystem supports both AXI4-Stream Video and Native Video interface.

- When **AXI4-Stream** is selected, an AXI4-Stream to Video Out core is used to support the HDMI 1.4/2.0 TX Subsystem. Because the AXI4-Stream carries only active video data, the AXI4-Stream to Video Out core takes input from an AXI4-Stream slave interface and converts it into a Native Video stream, which is then fed to the HDMI TX core.

- When **Native Interface** is selected, the native video stream must be prepared and fed to the Video_In port of the HDMI 1.4/2.0 Transmitter Subsystem, which is directly connected to the HDMI TX core inside the HDMI 1.4/2.0 Transmitter Subsystem.

The HDMI 1.4/2.0 Transmitter Subsystem is designed to support both progressive and interlaced video. This section, the focus is to show how to handle interlaced video as it is more straightforward for progressive video.

Taking 1920x1080@50Hz (I) as an example, the detail timing information is shown in **Table 3-2**.

**Table 3-2: Timing Data**

<table>
<thead>
<tr>
<th>Name</th>
<th>Timing Field Subset</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>HActive</td>
<td></td>
<td>1920</td>
</tr>
<tr>
<td>HBlank</td>
<td></td>
<td>720</td>
</tr>
<tr>
<td>HFrontPorch</td>
<td></td>
<td>528</td>
</tr>
<tr>
<td>HSyncWidth</td>
<td></td>
<td>44</td>
</tr>
<tr>
<td>HBackPorch</td>
<td></td>
<td>148</td>
</tr>
<tr>
<td>HTotal</td>
<td></td>
<td>2640</td>
</tr>
<tr>
<td>VActive</td>
<td></td>
<td>540</td>
</tr>
<tr>
<td>F0VBlank</td>
<td></td>
<td>22</td>
</tr>
<tr>
<td>F0PVFrontPorch</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>F0PVSyncWidth</td>
<td></td>
<td>5</td>
</tr>
<tr>
<td>F0PVBackPorch</td>
<td></td>
<td>15</td>
</tr>
<tr>
<td>F0PVTotal</td>
<td></td>
<td>562</td>
</tr>
<tr>
<td>F1VBlank</td>
<td></td>
<td>23</td>
</tr>
<tr>
<td>F1VFrontPorch</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>F1VSyncWidth</td>
<td></td>
<td>5</td>
</tr>
</tbody>
</table>
For interlaced video, each frame consists two fields. One field carries the odd lines and the other field carries the even lines. After putting both fields together, you get the complete frame. Therefore,

- Vertical Active per Field = Vertical Active Lines / 2
- Frame Rate = Field Rate / 2.

In this example,

VActive = 1080/2 = 540
Field Rate = 50Hz
Frame Rate = 50 / 2 = 25Hz

To design using the AXI4-Stream Interface, generate two fields of video with timing using the values from Table 3-2. For complete timing information, refer to CEA-861-F [Ref 28]. Only active video data compliant with AXI4-Stream protocol is needed. The AXI4-Stream to Video Out core inside HDMI 1.4/2.0 Transmitter Subsystem converts the AXI4-Stream video into native video. Ensure that fid is driven to align with the field video data. For details, refer to AXI4-Stream to Video Out LogiCORE IP Product Guide (PG044) [Ref 27].

To design using the Native Interface, generate two fields native video with timing using the values from Table 3-2. Ensure that the HSYNC and VSYNC are driven using the values from Table 3-2. Since a frame may have odd number of lines (e.g. 1125 for 1080i50), the two fields may result in a different total number of lines (e.g. Field 0 has 522 lines, and Field 1 has 523 lines).

### Interlaced Video with Pixel Repetition

For some video formats with TMDS rates below 25 Mhz (e.g. 13.5 for 480i/NTSC) can be transmitted using pixel-repetition scheme.

In the HDMI 1.4/2.0 Transmitter Subsystem,

- Enabled through GUI parameter upon IP generation (select Video over AXIS compliant NTSC/PAL Support)
- Pixel repetition is only available for AXI4-Stream Interface

**Note:** Using AXI4-Stream, Pixel Repetition only supports RGB and YUV444 color space, but not 12-bit YUV422. Using Native Interface creates customized pixel replication logic that supports all color spaces including 12-bit YUV422.
After it is enabled in the HDMI 1.4/2.0 Transmitter Subsystem, you must prepare interlaced video as normal, then the HDMI 1.4/2.0 Transmitter Subsystem replicates each pixel twice before sending the data out.

Because only NTSC/480i60 and PAL/576i50 are supported for pixel repetition, ensure that the correct XVDIC from the Video Common library is selected:

- XVIDC_VM_1440x576_50_I => PAL/576i50
- XVIDC_VM_1440x480_60_I => NTSC/480i60

For example, 480i60 video is 720x480 @ 30Hz, which is made from two fields of 720x240 @ 30Hz video.

You must select XVIDC_VM_1440x480_60_I in the software. Then in the hardware system, prepare two fields of 720x240 @ 30Hz video (AXI4-Stream Video) and send them to the HDMI 1.4/2.0 Transmitter Subsystem. Then HDMI 1.4/2.0 Transmitter Subsystem repeats each pixel twice. When the video is sent out by the HDMI 1.4/2.0 Transmitter Subsystem, it is sent as two fields of 1440x240 @ 30Hz video.

### Clocking

The S_AXI_CPU_IN, VIDEO_IN, and AUDIO_IN can be run at their own clock rate. The HDMI link interfaces and native video interface also run at their own clock rate. Therefore, five separate clock interfaces are provided called s_axi_cpu_aclk, s_axis_video_aclk, s_axis_audio_aclk, link_clk, and video_clk respectively.

The audio streaming clock must be greater than or equal to 128 times the audio sample frequency. Because audio clock regeneration is not part of the HDMI TX subsystem, you must provide an audio clock to the application. This can be achieved by using an internal PLL or external clock source.
**IMPORTANT:** As stated in HDMI 1.4b Specification section 7.2.4: For any IEC 61937 compressed audio with an IEC 60958 frame rate at or below 192kHz, the ACR fs value shall be equal to the frame rate. For any such stream with an IEC 60958 frame rate above 192kHz, the ACR fs value shall be 1/4th of the frame rate. Therefore, for HBR audio, while calculating N & CTS, the fs to be used is 1/4th of the frame rate. (e.g. 768kHz => 768/4=192kHz).

The HDMI clock structure is illustrated in Figure 3-11 and Table 3-3.

**Figure 3-11:** HDMI Clocking Structure

**Table 3-3:** Clocking

<table>
<thead>
<tr>
<th>Clock</th>
<th>Function</th>
<th>Freq/Rate</th>
<th>Example[^1]</th>
</tr>
</thead>
<tbody>
<tr>
<td>TMDS clock</td>
<td>Source synchronous clock to HDMI interface</td>
<td>1/10 data rate</td>
<td>Data rate = 2.97 Gb/s</td>
</tr>
<tr>
<td></td>
<td>(This is the actual clock on the HDMI cable).</td>
<td>(for data rates &lt; 3.4 Gb/s)</td>
<td>TMDS clock = 2.97/10 = 297 MHz</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1/40 data rate</td>
<td>Data rate = 5.94 Gb/s</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(for data rates &gt; 3.4 Gb/s)</td>
<td>TMDS clock = 5.94/40 = 148.5 MHz</td>
</tr>
<tr>
<td>Data clock</td>
<td>This is the actual data rate clock. This</td>
<td>TMDS clock</td>
<td>Data rate = 2.97 Gb/s</td>
</tr>
<tr>
<td></td>
<td>clock. This clock is not used in the</td>
<td>(for data rates &lt; 3.4 Gb/s)</td>
<td>Data clock = TMDS clock * 1 = 297 MHz</td>
</tr>
<tr>
<td></td>
<td>system. It is only listed to illustrate the</td>
<td>TMDS clock * 4</td>
<td>Data rate = 5.94 Gb/s</td>
</tr>
<tr>
<td></td>
<td>clock relations.</td>
<td>(for data rates &gt; 3.4 Gb/s)</td>
<td>Data clock = TMDS clock * 4 = 594 MHz</td>
</tr>
<tr>
<td></td>
<td></td>
<td>TMDS clock = 148.5 MHz</td>
<td>TMDS clock = 148.5 MHz</td>
</tr>
</tbody>
</table>
Table 3-3: Clocking (Cont’d)

<table>
<thead>
<tr>
<th>Clock</th>
<th>Function</th>
<th>Freq/Rate</th>
<th>Example&lt;sup&gt;(1)&lt;/sup&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link clock</td>
<td>Clock used for data interface between HDMI PHY Layer Module and subsystem</td>
<td>for dual pixel video clock=data clock/2 for quad pixel video clock=data clock/4</td>
<td>TMDS clock = 297 MHz Data clock = 297 MHz Link clock = 297 MHz/2 = 148.5 MHz for dual pixel wide interface Link clock = 297 MHz/4 = 74.25 MHz for quad pixel wide interface Data clock = 594 MHz Link clock = 594 MHz/4 = 148.5 MHz Link clock = 594 MHz/2 = 297 MHz for dual pixel wide interface Link clock = 594 MHz/4 = 148.5 MHz for quad pixel wide interface</td>
</tr>
<tr>
<td>Pixel clock</td>
<td>This is the internal pixel clock. This clock is not used in the system. It is only listed to illustrate the clock relations.</td>
<td>for 8 bpc pixel clock = data clock for 10 bpc pixel clock = data clock/1.25 for 12 bpc pixel clock = data clock/1.5 for 16 bpc pixel clock = data clock/2</td>
<td>297 MHz/2 = 148.5 MHz for dual pixel wide interface 297 MHz/4 = 74.25 MHz for quad pixel wide interface For more information on how to choose the correct PLL in the targeted devices, see the Video PHY Controller LogiCORE IP Product Guide (PG230) [Ref 24].</td>
</tr>
<tr>
<td>Video clock</td>
<td>Clock used for video interface</td>
<td>for dual pixel video clock = pixel clock/2 for quad pixel video clock = pixel clock/4</td>
<td>297 MHz/2 = 148.5 MHz for dual pixel wide interface 297 MHz/4 = 74.25 MHz for quad pixel wide interface For more information on how to choose the correct PLL in the targeted devices, see the Video PHY Controller LogiCORE IP Product Guide (PG230) [Ref 24].</td>
</tr>
</tbody>
</table>

Notes:
1. The examples in the Example column are only for reference and do not cover all the possible resolutions. Each GT has its own hardware requirements and limitations. Therefore, to use the HDMI 1.4/2.0 Transmitter Subsystem with different GT devices, calculate the clock frequencies and make sure the targeted device is able to support it. When using the HDMI 1.4/2.0 Transmitter Subsystem with Xilinx Video PHY Controller IP core, more information can be found in Video PHY Controller LogiCORE IP Product Guide (PG230) [Ref 24].

For example, 1080p60, 12BPC, and 2PPC are used to show how all the clocks are derived.

<table>
<thead>
<tr>
<th>Video Resolution</th>
<th>Horizontal Total</th>
<th>Horizontal Active</th>
<th>Vertical Total</th>
<th>Vertical Active</th>
<th>Frame Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080p60</td>
<td>2200</td>
<td>1920</td>
<td>1125</td>
<td>1080</td>
<td>60</td>
</tr>
</tbody>
</table>

Pixel clock represents the total number of pixels need to be sent every second. Therefore,
Chapter 3: Designing with the Subsystem

Pixel clock = Htotal \times Vtotal \times \text{Frame Rate}
= 2200 \times 1125 \times 60
= 148,500,000
= 148.5\text{Mhz}

Video clock = \frac{\text{Pixel clock}}{PPC}=148.5/2=74.25 \text{ Mhz}

Data clock = \text{Pixel clock} \times \text{BPC}/8=148.5 \times 12/8=222.75 \text{ Mhz}

Link clock = \frac{\text{Data clock}}{PPC}=222.75/2=111.375 \text{ Mhz}

Using the associative property in this example,

Data clock = 222.75\text{Mhz} < 340\text{Mhz}

then

TMDS clock = \text{Data clock} = 222.75\text{Mhz}

Figure shows how the clock is distributed in HDMI TX Subsystem and the relationship to the Video PHY Controller.

The HDMI TX Subsystem is able to support either AXI4-Stream Video or Native Video.

- When AXI4-Stream is selected, the video stream is sent to HDMI TX Subsystem through Video Interface in AXI4-Stream format running at axis_video_aclk. The AXI4-Stream is then processed and converted into Native Video stream by AXI4-Stream to Video Out Bridge core with the help of Video Timing Controller module. Because the AXI4-Stream carries only active video data, the AXI4-Stream to Video Out core takes input from an AXI4-Stream slave interface and converts it into...
a Native Video stream, which is then fed to the HDMI TX core. The HDMI TX Core then pack the native video data with Audio data and other auxiliary data into Link Data and sent to Video PHY Controller at Link Clock.

- When **Native Interface** is selected, Video stream is sent to HDMI TX Subsystem as native video and directly passed to HDMI TX core. The data are then packed and binded with Audio data and other auxiliary data into Link Data and sent to Video PHY Controller at Link Clock.

Based on the system requirement, Video PHY Controller is generating Link Clock and Video Clock for HDMI TX Subsystem for each targeted video resolution. Meanwhile, the `axis_audio_aclk`, `axis_video_aclk`, and AXI4-Lite clocks are free running clocks in the system usually generated by clock wizard with reference to some on-board oscillators.

### Resets

Each AXI interface has its own reset signal. The reset signals, `s_axi_cpu_arstn`, `s_axis_video_arstn` and `s_axis_audio_arstn` are for `S_AXI_CPU_IN`, `VIDEO_IN` (AXI4-Stream Video Interface), and `AUDIO_IN` respectively. These three reset signals are active-Low. Because the reset signal is used across multiple sub-blocks in the subsystem, keep the system in the reset state until all the clocks are stabilized. You can use the `locked` signal from the clock generation block as a reset signal.

**Note:** There is no dedicated hardware reset for `VIDEO_IN` interface when Native Video interface is selected. However, HDMI TX Subsystem outputs a `video_rst` signal, which you can use to reset its Native Video Source generation modules.
Chapter 4

Design Flow Steps

This chapter describes customizing and generating the subsystem, constraining the subsystem, and the simulation, synthesis and implementation steps that are specific to this IP subsystem. More detailed information about the standard Vivado® design flows and the IP integrator can be found in the following Vivado Design Suite user guides:

- **Vivado Design Suite User Guide: Designing IP Subsystems using IP Integrator** (UG994) [Ref 16]
- **Vivado Design Suite User Guide: Designing with IP** (UG896) [Ref 17]
- **Vivado Design Suite User Guide: Getting Started** (UG910) [Ref 18]

Customizing and Generating the Subsystem

This section includes information about using Xilinx tools to customize and generate the subsystem in the Vivado Design Suite.

The HDMI 1.4/2.0 Transmitter Subsystem can be added to a Vivado IP integrator block design in the Vivado Design Suite and can be customized using IP catalog. For more detailed information on customizing and generating the subsystem in the Vivado IP integrator, see the *Vivado Design Suite User Guide: Designing IP Subsystems using IP Integrator* (UG994) [Ref 16]. IP integrator might auto-compute certain configuration values when validating or generating the design. To check whether the values do change, see the description of the parameter in this chapter. To view the parameter value, run the `validate_bd_design` command in the Tcl Console.

You can customize the subsystem for use in your design by specifying values for the various parameters associated with the IP subsystem using the following steps:

1. In the **Flow Navigator**, click on **Create Block Diagram** or **Open Block Design** under the IP Integrator heading.
2. Right click in the diagram and select **Add IP**.
   
   A searchable IP catalog opens. You can also add IP by clicking on the Add IP button on the left side of the IP Integrator Block Design canvas.
3. Click on the IP name and press the Enter key on your keyboard or double click on the IP name.

4. Double-click the selected IP block or select the **Customize Block** command from the right-click menu.

For details, see the *Vivado Design Suite User Guide: Designing with IP* (UG896) [Ref 17] and the *Vivado Design Suite User Guide: Getting Started* (UG910) [Ref 18].

**Note:** Figures in this chapter are illustrations of the Vivado Integrated Design Environment (IDE). The layout depicted here might vary from the current version.

**Top Level Tab**

The Top level tab is shown in Figure 4-1.

![Figure 4-1: Top level Tab](image)

The parameters on the Top level tab are as follows:

**Component Name:** The component name is set automatically by IP Integrator.

**Video Interface:** This option selects the Video Interface for the HDMI TX subsystem. The allowable options are **AXIS-Stream** or **Native Video**.
Include HDCP 1.4 Encryption: This option enables HDCP 1.4 encryption.

Include HDCP 2.2 Encryption: This option enables HDCP 2.2 encryption.

Note: HDCP 1.4 and 2.2 Encryption options are only configurable if you have a HDCP license, else it is disabled and greyed out from the GUI.

Max bits per component: This option selects the maximum bits per component. The allowable options are, 8, 10, 12 or 16 bits. This parameter is to set the maximum "allowed" bits per component, and the actual bits per component can be set from the software API to a different value. However, the actual bits per component is bounded by the Max bits per component. For example, if the Max bits per component is set to 16, you can set the actual bits per component from the software API to any of the values, 8, 10, 12 or 16. But if the Max bits per component is set to 8, you should only set the actual bits per component to 8 through the software API. See Table 3-1 for more details on bit mapping.

Number of pixels per clock on Video Interface: This option selects the number of pixels per clock. The allowable options are 2 or 4 pixels.

IMPORTANT: Pixels per clock (PPC) can only be selected at IP generation time, and must remain static in the design. Some video format with a total horizontal resolution that is NOT divisible by 4 (for example, 720p60 has a total horizontal pixel of 1650, which is not divisible by 4) are not supported. If the design is intended to support this kind of video formats, ensure that PPC=2 is selected in Vivado.

Video over AXIS compliant NTSC/PAL Support: This option enables the HDMI TX subsystem to support Video over AXIS compliant NTSC/PAL.

• A pixel repetition of 2 is supported by current hardware
• 480i60 and 576i50 resolutions are supported in current software.
• Set the corresponding fields in the AVI InfoFrame so that the Pixel repetition information is sent to the HDMI sink device.

Note: Using AXI4-Stream, Pixel Repetition only supports RGB and YUV444 color space, but not 12-bit YUV422. Using Native Interface, user can create customized pixel replication logic to support all color spaces including 12-bit YUV422.

Video over AXIS compliant YUV420 Support: This option enables the HDMI TX subsystem to support Video over AXIS compliant YUV420.

IMPORTANT: For YUV420 Video, the line width is doubled, therefore, all the horizontal resolution fields must be divided by 2 to be supported in the HDMI TX Subsystem. For example, when PPC=2 is selected in the Vivado IDE, the total horizontal resolution must be divisible by 4 (instead of 2). In this case, because 720p60 has a total horizontal pixel of 1650, which is not divisible by 4, it is not supported for YUV420 format. Similarly, when PPC=4 is selected in Vivado, the total horizontal resolution need to be divisible by 8 (instead of 4).
**Hot Plug Detect Active**: This option selects the HPD active polarity. The allowable options are High or Low.

**Video Bridge Tab**

The Video Bridge tab is shown in Figure 4-2.

![Video Bridge Tab](image)

*Figure 4-2: Video Bridge Tab*

The parameters on the Video Bridge tab are as follows:

**Hysteresis Level**: Allowable range: 0—1023. Defines the “cushion” level of the frame buffer, that is, the number of locations that are considered the minimum fill level for FIFO operation to start. Generally, this value should be between 12 and 20. It must be at least 16 less than the depth of the FIFO, and at least 16 less than the number of active video lines.

**FIFO Depth**: Specifies the number of locations in the input FIFO. The allowable values are 32, 1024, 2048, 4096, and 8192.
Example Design Tab

The Example Design tab is shown in Figure 4-3.

Design Topology: Allows you to choose the topology of example design to be generated. The allowable options are Pass-Through, Tx Only, and Pass-Through+ I2S Audio (ZCU102 Only).

where,

- Pass-Through showcases the HDMI system built with one HDMI TX Subsystem and one HDMI RX Subsystem, sharing the same Video PHY Controller.
- Tx Only showcases the HDMI system built with only one HDMI TX Subsystem and Video PHY Controller. A Frame CRC helper core is added to the Tx Only topology to facilitate system monitor and debugging. An illustration is shown in figure below.
**Chapter 4: Design Flow Steps**

- **Pass-Through + I2S Audio (ZCU102 Only)** showcases the I2S Audio functionality using HDMI as carrier for the video. Unlike the Pass-Through design, the HDMI RX Audio is forwarded to HDMI TX to playback. In Pass-Through + I2S Audio system, the HDMI RX audio is forwarded to I2S TX. Similarly, the I2S RX audio is passed to HDMI TX for playback. A system illustration is shown in the figure below.

**Axilite Frequency**: Allows you to choose AXI4-Lite CPU clock. In this release, the following options have been verified.

- **GTX/7 Series**: 50MHz, 100MHz, 150MHz
- **UltraScale/UltraScale+ Devices**: 50MHz, 100MHz, 150MHz, 200Mhz
Video Phy Controller Setting Section: Allows the configuration of the Transmitter PLL type and Receiver PLL Type to the Video PHY Controller prior generating the example design. It also allows user to selectively opt-out the NI-DRU to optimize resource utilization if the video resolution they plan to support doesn't require NI-DRU. Refer to Video PHY Controller Product Guide [Ref 24] for details about NI-DRU requirements.

Example Design Overview Section: A system block diagram to show the overview of the example design to be generated.

IMPORTANT: When the Example Design targets VCU118 board and Design Topology is set to Pass-Through, the Include NIDRU option under Video PHY Controller Setting is grayed out and unchecked by default.

Native Video Interface Option

The native video interface option window is shown in Figure 4-6.

![Native Video Interface Option](image)

Include HDCP 1.4 Encryption: This option enables HDCP 1.4 encryption.

Include HDCP 2.2 Encryption: This option enables HDCP 2.2 encryption.

Note: HDCP 1.4 and 2.2 Encryption options are only configurable if you have a HDCP license, else it is disabled and cannot be selected from the GUI.

IMPORTANT: The Open Example Design is not supported for Native Video Interface. Therefore, the Example Design Tab is not available when Native Video is selected.
**User Parameters**

Table 4-1 shows the relationship between the fields in the Vivado IDE and the User Parameters (which can be viewed in the Tcl Console).

**Table 4-1:  Vivado IDE Parameter to User Parameter Relationship**

<table>
<thead>
<tr>
<th>Vivado IDE Parameter/Value</th>
<th>User Parameter/Value</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Toplevel</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video Interface</td>
<td>C_VID_INTERFACE</td>
<td>AXI4-Stream</td>
</tr>
<tr>
<td>AXI4-Stream</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>Native Video</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Include HDCP 1.4 Encryption</td>
<td>C_INCLUDE_HDCP_1_4</td>
<td>Exclude</td>
</tr>
<tr>
<td>Exclude (Untick)</td>
<td></td>
<td>FALSE</td>
</tr>
<tr>
<td>Include (Tick)</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>Include HDCP 2.2 Encryption</td>
<td>C_INCLUDE_HDCP_2_2</td>
<td>Exclude</td>
</tr>
<tr>
<td>Exclude (Untick)</td>
<td></td>
<td>FALSE</td>
</tr>
<tr>
<td>Include (Tick)</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>Video over AXIS compliant NTSC/PAL Support</td>
<td>C_INCLUDE_LOW_RESO_VID</td>
<td>Exclude</td>
</tr>
<tr>
<td>Exclude (Untick)</td>
<td></td>
<td>FALSE</td>
</tr>
<tr>
<td>Include (Tick)</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>Video over AXIS compliant YUV420 Support</td>
<td>C_INCLUDE_YUV420_SUP</td>
<td>Exclude</td>
</tr>
<tr>
<td>Exclude (Untick)</td>
<td></td>
<td>FALSE</td>
</tr>
<tr>
<td>Include (Tick)</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>Max bits per component</td>
<td>C_MAX_BITS_PER_COMPONENT</td>
<td>8</td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of pixels per clock on Video Interface</td>
<td>C_INPUT_PIXELS_PER_CLOCK</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hot Plug Detect Active</td>
<td>C_HPD_INVERT</td>
<td>High</td>
</tr>
<tr>
<td>High</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Low</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Video Bridge</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hysteresis Level</td>
<td>C_HYSTERESIS_LEVEL</td>
<td>12</td>
</tr>
</tbody>
</table>
Table 4-1: Vivado IDE Parameter to User Parameter Relationship (Cont’d)

<table>
<thead>
<tr>
<th>Vivado IDE Parameter/Value</th>
<th>User Parameter/Value</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>FIFO Depth</td>
<td>C_ADDR_WIDTH</td>
<td>1024</td>
</tr>
<tr>
<td>32</td>
<td>32</td>
<td></td>
</tr>
<tr>
<td>1024</td>
<td>1024</td>
<td></td>
</tr>
<tr>
<td>2048</td>
<td>2048</td>
<td></td>
</tr>
<tr>
<td>4096</td>
<td>4096</td>
<td></td>
</tr>
<tr>
<td>8192</td>
<td>8192</td>
<td></td>
</tr>
</tbody>
</table>

Example Design

<table>
<thead>
<tr>
<th>Design Topology</th>
<th>C_EXDES_TOPOLOGY</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pass-Through</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>Tx Only</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Pass-Through + I2S Audio</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>AXI-Lite Frequency</td>
<td>C_EXDES_AXILITE_FREQ</td>
<td>100</td>
</tr>
<tr>
<td>50</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>100</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>150</td>
<td>150</td>
<td></td>
</tr>
<tr>
<td>200</td>
<td>200</td>
<td></td>
</tr>
<tr>
<td>TX PLL Type</td>
<td>C_EXDES_TX_PLL_SELECTION</td>
<td>0 (GTXE2) 6 (GTHE3/4)</td>
</tr>
<tr>
<td>CPLL</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>QPLL(GTXE2)</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>QPLL01(GTHE3/4)</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>RX PLL Type</td>
<td>C_EXDES_RX_PLL_SELECTION</td>
<td>3 (GTXE2) 0 (GTHE3/4)</td>
</tr>
<tr>
<td>CPLL</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>QPLL(GTXE2)</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>QPLL01(GTHE3/4)</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>Include NIDRU</td>
<td>C_EXDES_NIDRU</td>
<td>true</td>
</tr>
<tr>
<td>Include (Tick)</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>Exclude (Untick)</td>
<td>false</td>
<td></td>
</tr>
</tbody>
</table>

Output Generation

For details, see the Vivado Design Suite User Guide: Designing with IP (UG896) [Ref 17].
Constraining the Subsystem

This section contains information about constraining the subsystem in the Vivado Design Suite.

Required Constraints

There are clock frequency constraints for the s_axi_cpu_aclk, s_axis_video_aclk, s_axis_audio_aclk, link_clk, and video_clk. For example,

```plaintext
create_clock -name s_axi_cpu_aclk -period 10.0 [get_ports s_axi_cpu_aclk]
create_clock -name s_axis_audio_aclk -period 10.0 [get_ports s_axis_audio_aclk]
create_clock -name link_clk -period 13.468 [get_ports link_clk]
create_clock -name video_clk -period 6.734 [get_ports video_clk]
create_clock -name s_axis_video_aclk -period 5.0 [get_ports s_axis_video_aclk]
```

When using this subsystem in the Vivado® Design Suite flow with Video PHY Controller modules, link_clk and video_clk are generated from the Video PHY Controller. Therefore, the clock constraints are set to the Video PHY Controller constraints instead of these generated clocks. See Clocking in the Video PHY Controller LogiCORE™ IP Product Guide (PG230) [Ref 24] for more information.

s_axi_cpu_aclk, s_axis_video_aclk, and s_axis_audio_aclk constraints are generated at system-level, for example by using a clock wizard.

Device, Package, and Speed Grade Selections

For more information on the device constraint/dependency, see the Video PHY Controller LogiCORE IP Product Guide (PG230) [Ref 24].

Table 4-2 shows the device and speed grade selections for HDMI 1.4/2.0 Transmitter Subsystem.

Table 4-2: Device and Speed Grade Selections

<table>
<thead>
<tr>
<th>Device Family</th>
<th>PPC</th>
<th>2</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>BPC</td>
<td>8</td>
<td>10</td>
</tr>
<tr>
<td>Speed Grade</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zynq-7000 SoC</td>
<td>-1</td>
<td>HDMI 1.4(1)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>-2</td>
<td>HDMI 2.0(2)</td>
<td></td>
</tr>
<tr>
<td>Zynq UltraScale+ MPSoC</td>
<td>-1</td>
<td>HDMI 2.0(2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>-2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 4-2:  Device and Speed Grade Selections (Cont’d)

<table>
<thead>
<tr>
<th>Device Family</th>
<th>PPC</th>
<th>2</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>BPC</td>
<td>8</td>
<td>10</td>
</tr>
<tr>
<td>Speed Grade</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Artix-7</td>
<td>−1</td>
<td>HDMI 1.4(1)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>−2</td>
<td>HDMI 1.4(1)</td>
<td></td>
</tr>
<tr>
<td>Kintex-7</td>
<td>−1</td>
<td>HDMI 1.4(1)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>−2</td>
<td>HDMI 2.0(2)</td>
<td></td>
</tr>
<tr>
<td>Kintex UltraScale</td>
<td>−1</td>
<td>HDMI 2.0(2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>−2</td>
<td>HDMI 2.0(2)</td>
<td></td>
</tr>
<tr>
<td>Virtex-7</td>
<td>−1</td>
<td>HDMI 1.4(1)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>−2</td>
<td>HDMI 2.0(2)</td>
<td></td>
</tr>
<tr>
<td>Virtex UltraScale</td>
<td>−1</td>
<td>HDMI 2.0(2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>−2</td>
<td>HDMI 2.0(2)</td>
<td></td>
</tr>
<tr>
<td>Virtex UltraScale+</td>
<td>−1</td>
<td>HDMI 2.0(2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>−2</td>
<td>HDMI 2.0(2)</td>
<td></td>
</tr>
</tbody>
</table>

Notes:
1. All HDMI 1.4 resolutions can be supported.
2. Full HDMI 2.0 resolutions support up to 4096 x 2160 @ 60fps.

Clock Frequencies

See Clocking in Chapter 3 for more information.

Clock Management

This section is not applicable for this IP subsystem.

Clock Placement

This section is not applicable for this IP subsystem.

Banking

This section is not applicable for this IP subsystem.

Transceiver Placement

This section is not applicable for this IP subsystem.
Chapter 4: Design Flow Steps

I/O Standard and Placement
This section is not applicable for this IP subsystem.

Simulation
Simulation of the subsystem is not supported.

Synthesis and Implementation
For details about synthesis and implementation, see the *Vivado Design Suite User Guide: Designing with IP* (UG896) [Ref 17].
Example Design

This chapter contains step-by-step instructions for generating an HDMI Example Design from the HDMI 1.4/2.0 Transmitter Subsystem by using Vivado® Flow.

Summary

HDMI 1.4/2.0 Transmitter Subsystem allows users to customize the example design based on their system requirements. Table 5-1 shows a summary on the hardware required for each targeted board, supported processors, topologies, and corresponding SDK Import Example options.

Table 5-1: Example Design Support Summary

<table>
<thead>
<tr>
<th>Development Boards</th>
<th>Additional Hardware</th>
<th>Processor</th>
<th>Topology</th>
<th>SDK Import Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>KC705/KCU105/VCU118(1)</td>
<td>inrevium TB-FMCH-HDMI4K FMC daughter card</td>
<td>MicroBlaze™</td>
<td>Pass-through</td>
<td>Passthrough_Microblaze</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tx Only</td>
<td>TxOnly_Microblaze</td>
</tr>
<tr>
<td>ZC706</td>
<td>A9</td>
<td></td>
<td>Pass-through</td>
<td>Passthrough_A9</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tx Only</td>
<td>TxOnly_A9</td>
</tr>
</tbody>
</table>
### Table 5-1: Example Design Support Summary (Cont’d)

<table>
<thead>
<tr>
<th>Development Boards</th>
<th>Additional Hardware</th>
<th>Processor</th>
<th>Topology</th>
<th>SDK Import Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZCU102(2)/ZCU104/ ZCU106</td>
<td>-</td>
<td>A53</td>
<td>Pass-through</td>
<td>Passthrough_A53</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Tx Only</td>
<td>TxOnly_A53</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Pass-Through</td>
<td>Repeater_A53(3)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Pass-Through + I2S Audio (ZCU102 Only)</td>
<td>Passthrough_Audio_I2S_A53</td>
</tr>
<tr>
<td>R5</td>
<td>Pass-through</td>
<td></td>
<td></td>
<td>Passthrough_R5</td>
</tr>
<tr>
<td></td>
<td>Tx Only</td>
<td></td>
<td></td>
<td>TxOnly_R5</td>
</tr>
</tbody>
</table>

**Notes:**
1. For VCU118 board, no dedicated on-board GT reference clocks are available to support HDMI Transmitter and NI-DRU on HDMI Receiver simultaneously due to board design limitation. Therefore, if Pass-through topology is selected for VCU118 board, NI-DRU is disabled.
2. The HDMI + I2S-PMOD Audio can only be generated ONLY using the configurations in Table 5-2.
3. A dedicated repeater application is added to demonstrate repeater functionality. Please take notes of below points:
   - Repeater feature has been removed from standard passthrough application for all the supported processors.
   - This application passes repeater compliance tests (CTS) on SL8800 running on ZCU102 A53 processor.
   - The same application can be used for other applications too.
   - User will need to increase the BRAM size from 512K to 1M in hardware IPI in order to run repeater function on Microblaze processor. This is because that the repeater functionality is more complex and requires more resources.

### Table 5-2: HDMI + I2S-PMOD Audio Configuration

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Board</td>
<td>ZCU102 Revision 1.x</td>
</tr>
<tr>
<td>Video Interface</td>
<td>AXI4-Stream</td>
</tr>
<tr>
<td>Include HDCP 1.4 Encryption</td>
<td>Disabled</td>
</tr>
<tr>
<td>Include HDCP 2.2 Encryption</td>
<td>Disabled</td>
</tr>
<tr>
<td>Video over AXIS compliant NTSC/PAL Support</td>
<td>Disabled</td>
</tr>
<tr>
<td>Video over AXIS compliant YUV420 Support</td>
<td>Disabled</td>
</tr>
<tr>
<td>Max bits per component</td>
<td>8</td>
</tr>
<tr>
<td>Number of pixels per clock on Video Interface</td>
<td>2</td>
</tr>
<tr>
<td>Design Topology</td>
<td>Pass-Through + I2S Audio</td>
</tr>
<tr>
<td>Axilite Frequency</td>
<td>100</td>
</tr>
<tr>
<td>Tx PLL Type</td>
<td>QPLL0/1</td>
</tr>
<tr>
<td>Rx PLL Type</td>
<td>CPLL</td>
</tr>
<tr>
<td>Include NIDRU</td>
<td>Enabled</td>
</tr>
</tbody>
</table>
This chapter covers the design considerations of a High-Definition Multimedia Interface (HDMI™) 2.0 implementation using the performance features of these Xilinx® LogiCORE™ IPs:

- HDMI 1.4/2.0 with HDCP 1.4/2.2 Transmitter Subsystem
- HDMI 1.4/2.0 with HDCP 1.4/2.2 Receiver Subsystem (For Pass-through topology Only)
- Video PHY Controller

The design features the transmit-only and the pass-through operation modes for the HDMI solution. In the transmit-only mode, the design displays a color bar pattern from the LogiCORE IP Test Pattern Generator (TPG) core. In the pass-through mode, an external HDMI source is used to send video data over the HDMI design. The reference design demonstrates the use of the High-bandwidth Digital Content Protection System (HDCP) Revision 1.4/2.2 capability of the HDMI solution. HDCP is used to securely send audiovisual data from an HDCP protected transmitter to HDCP protected downstream receivers. Typically, HDCP 2.2 is used to encrypt content at Ultra High Definition (UHD) while HDCP 1.4 is used as a legacy encryption scheme for lower resolutions.

**Hardware**

The example design is built around the HDMI 1.4/2.0 Transmitter Subsystem (HDMI_TX_SS), HDMI 1.4/2.0 Receiver Subsystem (HDMI_RX_SS) (Optional), Video PHY (VPHY) Controller core and leverages existing Xilinx IP cores to form the complete system. Figure 5-1 and Figure 5-2 are illustrations of Overall HDMI Example Design block diagram while targeting various Xilinx Evaluation Kits.

![Figure 5-1: KC705/KCU105/ZC706/VCU118 HDMI Example Design Block Diagram](image)
Chapter 5: Example Design

**IMPORTANT:** When an unpowered HDMI source is connected to the HDMI Receiver in a pass-through system, the HDMI Example Design UART may get flooded with Starting Colorbar message because of a limitation to the ZCU102 board design.

The VPHY Controller core has been configured for the HDMI application that allows transmission and reception (optional) of HDMI video/audio to and from the HDMI 2.0 daughter card or on-board HDMI 2.0 circuitry.

**Figure 5-2:** ZCU102/ZCU104/ZCU106 HDMI Example Design Block Diagram

**Figure 5-3:** KC705/KCU105/ZC706/VCU118 HDMI Reference Design Clock and Datapath Diagram
Chapter 5: Example Design

IMPORTANT: TI HDMI Cable driver chip DP159 is used in all the Example design, either on Evaluation board itself or on The inrevium TB-FMCH-HDMI4K FMC daughter card. In the HDMI Example Design software, a sample DP159 driver is provided as reference. The settings have not been calibrated for various use cases. If users are using DP159 in their product, they need to adjust the settings based on the circuit design. Some further fine tuning may still be needed according to the compliance results.

TMDS DATA PCB trace rules required to meet HDMI compliance requirements for the TMDS181 (only when RX is used) and SN68DP159 devices are as follows:

Inter-pair skew for DATA[0:2] lanes must be:
- Max 10ps inter-pair skew FPGA->retimer
- Max 10ps inter-pair skew retimer->connector

Intra-pair skew for DATA[0:2] lanes must be:
- Max 1ps intra-pair skew FPGA->retimer
- Max 1ps intra-pair skew retimer->connector
- Target impedance to be 100ohm +/-7% (Max +/-10%)
  - A single excursion is permitted out to a max/min of 100ohms +/-25% and of a duration less than 250ps

In pass-through mode, the VPHY Controller core recovers the high-speed serial video stream, converts it to parallel data streams, forwards it to the HDMI_RX_SS core, which
extracts the video and audio streams from the HDMI stream and converts it to separate AXI video and audio streams. The AXI video goes through the TPG core and the AXI audio goes through a customized audio generation block. The two AXI streams eventually reach the HDMI_TX_SS core, which converts the AXI video and audio streams back to an HDMI stream before being transmitted by the VPHY Controller core as a high-speed serial data stream. The transition minimized differential signaling (TMDS) clock from the HDMI In interface is forwarded to the HDMI TX transceiver via the SI53xx clock generator in the HDMI 2.0 FMC card or on-board HDMI 2.0 circuitry.

**Note:** ZCU104 uses a different clock generator IDT 8T49N24x. A sample driver is provided as part of example application software. It is not calibrated for the best performance or to pass compliance. You may need to fine tune its settings in their own design if the same chip is used in their product.

In TX only mode, the colorbar pattern is generated by the TPG in form of AXI video stream and the low frequency audio is generated by the customized audio processing block in form of AXI audio stream. The two streams are forwarded to the HDMI_TX_SS for HDMI stream conversion then to the VPHY for transmission.

High-level control of the system is provided by a simplified embedded processor subsystem containing I/O peripherals and processor support IP. A clock generator block and a processor system reset block supply clock and reset signals for the system, respectively. See Figure 5-5 and Figure 5-6 for a block diagrams of the three types of processor subsystems supported by HDMI Example Design flow.

**Figure 5-5:** HDMI Reference Design Block Diagram (MicroBlaze)
Example Design Specifics

In addition to the Video PHY Controller, HDMI Transmitter Subsystem and HDMI Receiver Subsystem core, the complete example design includes the following cores:

- MicroBlaze or Zynq or Zynq UltraScale+
- MicroBlaze Debug Module (Only for MicroBlaze based processor subsystem)
- AXI Interconnect
- Local Memory Bus (Only for MicroBlaze based processor subsystem)
- LMB BRAM Controller (Only for MicroBlaze based processor subsystem)
- Block Memory Generator (Only for MicroBlaze based processor subsystem)
- Clocking Wizard
- Processor System Reset
- AXI UARTLite (Only for MicroBlaze based processor subsystem)
- AXI Interrupt Controller (Only for MicroBlaze based processor subsystem)
- AXI IIC
- AXI GPIO
- Video Test Pattern Generator
- AXI4-Stream Register Slice
- Utility Buffer
- Utility Vector Logic
• AUD_PAT_GEN (Custom IP)
• HDMI_ACR_CTRL (Custom IP)
• HDCP_KEYMNGMT_BLK (Custom IP)

Note: When a Custom IP is added to a IPI design as RTL reference module, the auto assigned address may be maximized to any of the available space. Therefore, if you unmap AUD_PAT_GEN, HDMI_ACR_CTRL or HDCP_KEYMNGMT_BLK for the Example design, after reassigning the address, you must set the address to a smaller range (e.g. 64k).

Running the Example Design

1. Open the Vivado Design Suite and create a new project.
2. In the pop-up window, press Next until you get to the page to select Xilinx® part or board for the project.
3. Select the target Board, then click **Next > Finish**. (In this release, KC705, KCU105, ZC706, ZCU102, ZCU104, ZCU106 and VCU118 are supported.)

4. A Vivado Project opens. In **Flow Navigator > PROJECT MANAGER**, click **IP Catalog** to open it. Then double-click on **HDMI 1.4/2.0 Transmitter Subsystem** in **Video Connectivity**.

<table>
<thead>
<tr>
<th>IP Catalog</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cores</strong></td>
</tr>
<tr>
<td>🌑 🌑 🎨 🎨</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Name</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>🌑 Kernels</td>
<td></td>
</tr>
<tr>
<td>🌑 Math Functions</td>
<td></td>
</tr>
<tr>
<td>🌑 Memories &amp; Storage Elements</td>
<td></td>
</tr>
<tr>
<td>🌑 Partial Reconfiguration</td>
<td></td>
</tr>
<tr>
<td>🌑 SDAccel DSA Infrastructure</td>
<td></td>
</tr>
<tr>
<td>🌑 Standard Bus Interfaces</td>
<td></td>
</tr>
<tr>
<td>🌑 Video &amp; Image Processing</td>
<td></td>
</tr>
<tr>
<td>🌑 Video Connectivity</td>
<td></td>
</tr>
<tr>
<td>🌑 DisplayPort RX Subsystem</td>
<td></td>
</tr>
<tr>
<td>🌑 DisplayPort TX Subsystem</td>
<td></td>
</tr>
<tr>
<td>🌑 HDMI 1.4/2.0 Receiver Subsystem</td>
<td></td>
</tr>
<tr>
<td>🌑 HDMI 1.4/2.0 Transmitter Subsystem</td>
<td></td>
</tr>
<tr>
<td>🌑 MIPI CSI–2 Rx Subsystem</td>
<td></td>
</tr>
<tr>
<td>🌑 MIPI CSI–2 Tx Subsystem</td>
<td></td>
</tr>
</tbody>
</table>

5. A Customize IP window opens. Configure HDMI 1.4/2.0 Transmitter Subsystem, then select **OK**.
   a. Refer to **Chapter 4, Design Flow Steps** for detail description on Customizing and Generating the Subsystem.
   b. You may rename the IP component name, which is used as example design project name.
   c. Native Video Interface is NOT supported in Example Design Flow.
Chapter 5: Example Design

Example Design Overview:

Note: To generate the Application Example Design, right-click the subsystem in IPI canvas or design source and select Open IP example design.

HDMI 1.4/2.0 TX Subsystem

PG235 February 12, 2019

www.xilinx.com
6. The **Generate Output Products** dialog box opens. Select **Generate**.
a. You may optionally select **Skip** if you only want to create an example design and leave the IP generation to later stage.

7. The IP component with given name is added to **Design Sources**. Right click on it and select **Open IP Example Design**.
8. Choose the target Example project directory, then select **OK**.

9. A new Vivado project launches, in which a HDMI Example Design is generated with Block Design to show the system structure. You may choose to build the design by **Run Synthesis, Implementation, and Generate Bitstream**. An overall system IPI block diagram of the KC705 based example design is shown below.

***Note:*** If user clock the block design and re-open it again, then rerun Validate Design, below warning messages will be shown in the console, which doesn't have any functionality impact.

**WARNING:** [BD 41-1731] Type mismatch between connected pins: `/v_hdmi_tx/s_axis_video_aresetn_out(undef)` and `/v_axi4s_vid_out/aresetn(rst)`
10. After the Hardware is created successfully, the next step is to export the generated HDMI Example Design hardware to build HDMI application software using Xilinx SDK. To export hardware design, in the generated HDMI Example Design Vivado project, select **File > Export -> Export Hardware**.

11. In Export Hardware window opens, select **OK**. The hardware definition file is exported to a folder (usually .sdk folder) local to the Vivado project.

12. The Hardware is exported successfully. Then Launch SDK in the same generated HDMI Example Design Vivado project by selecting **File > Launch SDK**.

13. A Launch SDK window will open, Click OK to use the default location. Xilinx SDK is launched and Hardware design information is shown by default in system.hdf.

14. In the SDK project, user need to create a Board Support Package Project by selecting **File -> New -> Board Support Package**. When the New Board Support Package Project opens, select **Finish**.
Chapter 5: Example Design

15. A Board Support Package Settings window will open. Select OK to close it.

16. A tab to the system.mss will open. In the system.mss, there will be a section named Peripheral Drivers. From the list of Peripheral Drivers, find the HDMI 1.4/2.0 Transmitter Subsystem driver (v_hdmi_tx_ss) and click on Import Examples.
17. An Import Examples window opens with a list of applications. Refer to Table 5-1 to select the respective application and click OK.
18. The Example Application will be built and .elf will be ready to use.

**HDCP Key Utility**

An optional hdcp_key_utility application software is available for using the same hardware to program your own HDCP encryption keys into the EEPROM (FMC or on-board).

To hdcp_key_utility application:

1. Import Example from SDK and choose hdcp_key_utility.
2. Open hdcp_key_utility.c from the SDK project.
3. The arrays Hdcp22Lc128, Hdcp22Key, Hdcp14Key1, and Hdcp14Key2 hold the HDCP keys and are empty. Fill these arrays with the acquired HDCP keys. The arrays are defined in big endian byte order.
4. Save the file and compile the design.
5. Run the design.

The terminal displays the following output:

HDCP Key EEPROM v1.0  
This tool encrypts and stores the HDCP 2.2 certificate and HDCP 1.4 keys into the EEPROM on the HDMI FMC board  
Enter Password ->
The HDCP keys are encrypted using this password. The same password is used in the reference design to decrypt the HDCP keys.

The application is terminated after completing the programming of HDCP keys.

Note: The keys only need to be programmed into the EEPROM once.

**Formatting HDCP Keys for HDCP 1.x**

The hdcp_key_utility.c has two (empty) HDCP 1.x key arrays.

- The Hdcp14Key1 array
  This array holds the HDCP 1.x RX KSV and Keys.

- The Hdcp14Key2 array
  This array holds the HDCP 1.x RX KSV and Keys.

The arrays have a size of 328 bytes and contain the Key Selection Vector (KSV) (5 bytes padded with zeros to 8 bytes) and key set (320 bytes), where each key is 7 bytes padded with zeros to 8 bytes.

To format the HDCP 1.x keys for the key_utility, follow the steps below:

1. Discard the 20 byte SHA-1.
2. Pad each key on the right with one byte of 0s (KSV is already padded).
   You should now have 1 x 8 byte KSV + 40 x 8 byte Keys.
3. Byte swap each 8 byte set to reverse their order (convert from Little-endian to Big-endian).
   Note: The facsimile keys given in HDCP 1.4 spec are already in little-endian format, so byte swap is not needed when using them for test purpose.

   The final result should be a 328 byte HDCP 1.4 keyset.

**Formatting HDCP Keys for HDCP 2.2**

The hdcp_key_utility.c has two (empty) HDCP 2.2 key arrays.

- The hdcp22_lc128 array
  The global secret constant for the HDCP 2.2 TX. The size is 16 bytes and the license constant from the HDCP 2.2 TX certificate is placed into the array (position 4-19)

- The Hdcp22RxPrivateKey array
This array holds the HDCP 2.2 RX certificate. The array has a size of 902 bytes. The contents are the header (4), license constant (36 bytes) and key set (862), so the total is 902 bytes.

**Note:** If a pass-through example design is built which contains HDMI RX component, you can use the same `hdcp_key_utility` application to program the HDCP 2.2 RX Private Key.

### Running the Reference Design (MicroBlaze)

Use the following steps to execute the system using generated bitstream and software elf from the example design

1. Launch the Xilinx System Debugger by selecting **Start > All Programs > Xilinx Design Tools > Vivado 2018.3 > Vivado 2018.3 Tcl Shell**.
2. In the Xilinx command shell window, change to the Example Design Project directory:

   ```
   Vivado% cd ./<IP instance name>_ex
   ```

3. Invoke Xilinx System Debugger (xsdb).

   ```
   Vivado% xsdb
   ```

4. Establish connections to debug targets.

   ```
   xsdb% connect
   ```

5. Download the bitstream to the FPGA:

   ```
   xsdb% fpga -file ./<IP instance name>_ex.runs/impl_1/exdes_wrapper.bit
   ```

6. Set the target processor.

   ```
   xsdb% target -set 3
   ```

7. Download the software .elf to the FPGA.

   ```
   xsdb% dow ./<IP instance name>_ex.sdk/<name of bsp>_xhdmi_example_1/Debug/<name of bsp>_xhdmi_example_1.elf
   ```

8. Run the software.

   ```
   xsdb% stop
   xsdb% rst
   xsdb% con
   ```

9. Exit the XSDB command prompt.

   ```
   xsdb% exit
   ```
Running the Reference Design (A53 on Zynq UltraScale+ Devices)

1. Launch the Xilinx System Debugger by selecting Start > All Programs > Xilinx Design Tools > Vivado 2018.3 > Vivado 2018.3 Tcl Shell.

2. In the Xilinx command shell window, change to the Example Design Project directory:

   Vivado% cd ./<IP instance name>_ex

3. Invoke Xilinx System Debugger (xsdb).

   Vivado% xsdb

4. Establish connections to debug targets.

   xsdb% connect

5. List all available JTAG targets

   xsdb% targets

   1 PS TAP
   2 PMU
   3 PL
   4 PSU
   5 RPU (Reset)
   6 Cortex-R5 #0 (RPU Reset)
   7 Cortex-R5 #1 (RPU Reset)
   8 APU
   9* Cortex-A53 #0 (Running)
   10 Cortex-A53 #1 (Power On Reset)
   11 Cortex-A53 #2 (Power On Reset)
   12 Cortex-A53 #3 (Power On Reset)

   Note: Target number for PSU, PL, APU and Cortex-A53 may be different. Run the targets and ensure they are using the correct target number.

6. Download the bitstream to the FPGA:

   xsdb% targets -set 4 (PSU)
   xsdb% rst -system
   xsdb% after 3000
   xsdb% target -set 3 (PL)
   xsdb% fpga -file ./<IP instance name>_ex.runs/impl_1/exdes_wrapper.bit

7. Set the target processor.

   xsdb% target -set 8 (APU)
   xsdb% source ./<IP instance name>_ex.sdk/exdes_wrapper_hw_platform_0/psu_init.tcl
   xsdb% psu_init
   xsdb% after 1000
   xsdb% psu_ps_pl_isolation_removal
   xsdb% after 1000
   xsdb% psu_ps_pl_reset_config
   xsdb% catch (psu_protection)
   xsdb% target -set 9 (Cortex-A53 #0)
   xsdb% rst -processor
8. Download the software .elf to the FPGA

```
xsd% dow ./ <IP instance name>_ex.sdk/<name of bsp>_xhdmie_example_zynq_us_1/
    Debug/<name of bsp>_xhdmie_example_zynq_us_1.elf
```

9. Run the software.

```
xsd% con
```

10. Exit the XSDB command prompt.

```
xsd% exit
```

---

**Running the Reference Design (R5 on Zynq UltraScale+ Devices)**

1. Launch the Xilinx System Debugger by selecting Start > All Programs > Xilinx Design Tools > Vivado 2018.3 > Vivado 2018.3 Tcl Shell.

2. In the Xilinx command shell window, change to the Example Design Project directory:

```
Vivado% cd ./<IP instance name>_ex
```

3. Invoke Xilinx System Debugger (xsdb).

```
Vivado% xsdb
```

4. Establish connections to debug targets.

```
xsd% connect
```

5. List all available JTAG targets

```
xsd% targets
1  PS TAP
2  PMU
3  PL
4  PSU
5  RPU (Reset)
6* Cortex-R5 #0 (RPU Reset)
7  Cortex-R5 #1 (RPU Reset)
8  APU
9  Cortex-A53 #0 (Running)
10 Cortex-A53 #1 (Power On Reset)
11 Cortex-A53 #2 (Power On Reset)
12 Cortex-A53 #3 (Power On Reset)
```

*Note:* Target number for PSU, PL, RPU and Cortex-R5 may be different. Run the targets and ensure they are using the correct target number.

6. Download the bitstream to the FPGA:

```
xsd% targets -set 4 (PSU)
xsd% rst -system
xsd% after 3000
xsd% target -set 3 (PL)
xsd% fpga -file ./<IP instance name>_ex.runs/impl_1/exdes_wrapper.bit
```

7. Set the target processor.

```
xsd% target -set 5 (RPU)
```
xsdb% source ./<IP instance name>_ex.sdk/exdes_wrapper_hw_platform_0/psu_init.tcl
xsdb% psu_init
xsdb% after 1000
xsdb% psu_ps_pl_isolation_removal
xsdb% after 1000
xsdb% psu_ps_pl_reset_config
xsdb% catch {psu_protection}
xsdb% target -set 6 (Cortex-R5 #0)

xsdb% rst -processor

8. Download the software .elf to the FPGA

xsdb% dow ./<IP instance name>_ex.sdk/<name of bsp>_xhdmi_example_zynq_us_1/Debug/<name of bsp>_0_xhdmi_example_zynq_us_1.elf

9. Run the software.

xsdb% con

10. Exit the XSDB command prompt.

xsdb% exit

Running the Reference Design (A9 on Zynq)

1. Launch the Xilinx System Debugger by selecting Start > All Programs > Xilinx Design Tools > Vivado 2018.3 > Vivado 2018.3 Tcl Shell.

2. In the Xilinx command shell window, change to the Example Design Project directory:

   Vivado% cd ./<IP instance name>_ex

3. Invoke Xilinx System Debugger (xsdb).

   Vivado% xsdb

4. Establish connections to debug targets.

   xsdb% connect

5. List all available JTAG targets

   xsdb% targets

   1  APU
   2* ARM Cortex-A9 MPCore #0 (Suspended)
   3  ARM Cortex-A9 MPCore #1 (Suspended)
   4  xc7z045

6. Download the bitstream to the FPGA:

   xsdb% source <SDK Install folder>/scripts/sdk/util/zynqutils.tcl
   xsdb% targets -set 1 (APU)
   xsdb% rst -system
   xsdb% after 3000
xsdb% target -set 4 (xc7z045)
xbdb% fpga -file ./<IP instance name>_ex.runs/impl_1/exdes_wrapper.bit

7. Set the target processor.
xsdb% targets -set 1 (APU)
xbdb% loadhw ./<IP instance name>_ex.sdk/exdes_wrapper_hw_platform_0/
system.hdf
xsdb% targets -set 1 (APU)
xbdb% ps7_init
xsdb% ps7_post_config
xsdb% targets -set 2 (ARM Cortex-A9 MPCore #0)

8. Download the software .elf to the FPGA
xsdb% dow ./<IP instance name>_ex.sdk/<name of bsp>_Passthrough_A9_1/Debug/
<name of bsp>_Passthrough_A9_1.elf

9. Run the software.
xbdb% con

10. Exit the XSDB command prompt.
xbdb% exit

**IMPORTANT:** When using the TB-FMCH-HDMI4K example design with the KCU105 board, you must set the FMC VADJ_1V8 Power Rail before programming the FPGA with bitstream generated from Example Design Flow. KCU105 Board FMCH VADJ Adjustment shows the steps on how to set the VADJ power rail when using KCU105 board. For more details about KCU105 Board, to KCU105 Board User Guide [Ref 20].

---

**KCU105 Board FMCH VADJ Adjustment**

The KCU105 board system controller must apply power to the VADJ power rail for the HDMI 2.0 FMC card (TB-FMCH-HDMI4K). Most new boards are per-programmed and should be detected. The VADJ is powered when the DS19 LED (located near the power switch on the KCU105 board) is ON.

If an older version KCU105 board is used, or the board is not properly programmed upon receiving, you must manually set the VADJ power rail to 1.8V for the HDMI 2.0 FMC card prior to bitstream configuration.

Perform these steps to set the VADJ power rail through the UART terminal are:

1. Connect a USB cable between the USB UART connector of the KCU105 board and a PC running Windows.

2. Use the Windows Device Manager to determine which virtual COM port is assigned to the UART for the Zynq-7000 SoC system controller and which is assigned to the UART for the UltraScale FPGA. In the list of COM ports in the Device Manager window, the enhanced COM port associated with the CP210x, is the one connected to the KCU105.
board system controller and the standard COM port is the one connected to the FPGA UART.

3. Open a terminal window (115200, 8, N, 1) and set the COM port to the one communicating with the KCU105 board system controller.

4. After the UART terminal is connected, power cycle the KCU105 board to refresh the system controller menu in the UART terminal. Select this option in the system controller menu:
   a. Adjust FPGA Mezzanine Card (FMC) Settings.

5. In the next menu, select:
   a. Set FMC VADJ to 1.8V.

**IMPORTANT:** Ensure that the jumpers are set correctly on their HDMI 2.0 FMC daughter card.
Appendix A

Verification, Compliance, and Interoperability

Interoperability

Interoperability tests for the HDMI 1.4/2.0 Transmitter Subsystem have been conducted with the following hardware setup.

Hardware Testing

The HDMI 1.4/2.0 Transmitter Subsystem has been validated using

- Kintex®-7 FPGA Evaluation Kit (KC705)
- Kintex® UltraScale™ FPGA Evaluation Kit (KCU105)
- Inrevium Artix-7 FPGA ACDC A7 Evaluation Board
- Zynq®-7000 SoC evaluation board (ZC706)
- Zynq UltraScale+ MPSoC ZCU102 Evaluation Kit
- Zynq UltraScale+ MPSoC ZCU104 Evaluation Kit
- Zynq UltraScale+ MPSoC ZCU106 Evaluation Kit
- Virtex® UltraScale+™ FPGA VCU118 Evaluation Kit

The HDMI 1.4/2.0 Transmitter Subsystem is tested with the following sink devices:

- Quantum Data 980B
- Quantum Data 780B
- Dell U2414Q
- Dell U2412M
- Dell U2713HM
- Acer S277HK
• Asus PQ321
• Sharp TV (LC-60LE740E)
• Philips TV (7800 series)
• Samsung UHDTV (UE40HU6900S)
• Murideo video analyser / SIX-A
• DELL P2415Q
• Philips 288P6LJEB
• LG 27mu67

Video Resolutions

Figure A-1 shows the hardware setup for AXI4-Stream Video Interface. An HDMI source connects to Video PHY Controller, which converts the HDMI Video into LINK DATA and sends to the HDMI RX Subsystem. Then, the HDMI RX Subsystem translates the LINK DATA into AXI4-Stream Video and sends to the Test Pattern Generator. By setting the Test Pattern Generator to pass-through mode, the AXI4-Stream Video from the HDMI RX Subsystem is passed to HDMI TX Subsystem where it gets translated to LINK DATA again and sends back to the Video PHY Controller. The Video PHY Controller then converts it back to HDMI Video and sends to HDMI Sink.

The Test Pattern Generator can also be configured to generate certain video pattern in the AXI4-Stream video format, which can be used to test the HDMI TX Subsystem alone instead of relying on the video received from the HDMI RX Subsystem.
Appendix A: Verification, Compliance, and Interoperability

For Video PHY Controller settings and PLL selections, see the Video PHY Controller LogiCORE IP Product Guide (PG230) [Ref 24].

Similarly, Figure A-2 shows the hardware setup for Native Video Interface. The only difference is that two Video Bridge modules are added in between the HDMI RX Subsystem and the Test Pattern Generator, and between the Test Pattern Generator to the HDMI TX Subsystem.

This is because the Test Pattern Generator can be configured to generate certain video pattern in AXI4-Stream video format, which can be used to test the HDMI TX Subsystem alone instead of relying on the video received from the HDMI RX Subsystem.

Figure A-1: Test Setup for AXI4-Stream Video Interface
Table A-1, Table A-2, and Table A-3 show the video resolutions that were tested as part of the release for different video formats.

Table A-1: Tested Video Resolutions for RGB 4:4:4 and YCbCr 4:4:4

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Horizontal</th>
<th>Vertical</th>
<th>Frame Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Total</td>
<td>Active</td>
<td>Total</td>
</tr>
<tr>
<td>480i60</td>
<td>858</td>
<td>720</td>
<td>525</td>
</tr>
<tr>
<td>576i50</td>
<td>864</td>
<td>720</td>
<td>625</td>
</tr>
<tr>
<td>1080i50</td>
<td>2640</td>
<td>1920</td>
<td>1125</td>
</tr>
<tr>
<td>1080i60</td>
<td>2200</td>
<td>1920</td>
<td>1125</td>
</tr>
<tr>
<td>480p60</td>
<td>858</td>
<td>720</td>
<td>525</td>
</tr>
<tr>
<td>576p50</td>
<td>864</td>
<td>720</td>
<td>625</td>
</tr>
<tr>
<td>720p50</td>
<td>1980</td>
<td>1280</td>
<td>750</td>
</tr>
<tr>
<td>720p60</td>
<td>1650</td>
<td>1280</td>
<td>750</td>
</tr>
<tr>
<td>1080p24</td>
<td>2750</td>
<td>1920</td>
<td>1125</td>
</tr>
<tr>
<td>1080p25</td>
<td>2640</td>
<td>1920</td>
<td>1125</td>
</tr>
<tr>
<td>1080p30</td>
<td>2200</td>
<td>1920</td>
<td>1125</td>
</tr>
<tr>
<td>1080p50</td>
<td>2640</td>
<td>1920</td>
<td>1125</td>
</tr>
</tbody>
</table>
## Appendix A: Verification, Compliance, and Interoperability

### Table A-1: Tested Video Resolutions for RGB 4:4:4 and YCbCr 4:4:4 (Cont'd)

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Horizontal</th>
<th>Vertical</th>
<th>Frame Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Total</td>
<td>Active</td>
<td>Total</td>
</tr>
<tr>
<td>1080p60</td>
<td>2200</td>
<td>1920</td>
<td>1125</td>
</tr>
<tr>
<td>1080p120</td>
<td>2200</td>
<td>1920</td>
<td>1125</td>
</tr>
<tr>
<td>2160p24</td>
<td>5500</td>
<td>3840</td>
<td>2250</td>
</tr>
<tr>
<td>2160p25</td>
<td>5280</td>
<td>3840</td>
<td>2250</td>
</tr>
<tr>
<td>2160p30</td>
<td>4400</td>
<td>3840</td>
<td>2250</td>
</tr>
<tr>
<td>2160p60 (2)</td>
<td>4400</td>
<td>3840</td>
<td>2250</td>
</tr>
<tr>
<td>4096x2160p60 (2)</td>
<td>4400</td>
<td>4096</td>
<td>2250</td>
</tr>
<tr>
<td>vgap60</td>
<td>800</td>
<td>640</td>
<td>525</td>
</tr>
<tr>
<td>svgap60</td>
<td>1056</td>
<td>800</td>
<td>628</td>
</tr>
<tr>
<td>xgap60</td>
<td>1344</td>
<td>1024</td>
<td>806</td>
</tr>
<tr>
<td>sxgap60</td>
<td>1688</td>
<td>1280</td>
<td>1066</td>
</tr>
<tr>
<td>wxgap60</td>
<td>1440</td>
<td>1280</td>
<td>790</td>
</tr>
<tr>
<td>wxga+p60</td>
<td>1792</td>
<td>1366</td>
<td>798</td>
</tr>
<tr>
<td>ugap60</td>
<td>2160</td>
<td>1600</td>
<td>1250</td>
</tr>
<tr>
<td>wxugap60</td>
<td>2592</td>
<td>1920</td>
<td>1245</td>
</tr>
<tr>
<td>wxvgap60</td>
<td>2240</td>
<td>1680</td>
<td>1089</td>
</tr>
</tbody>
</table>

### Notes:
1. Not all resolutions can be supported due to VPHY limitation. For details, refer to Video PHY Controller LogiCORE IP Product Guide (PG230) [Ref 24].
2. For 4kp60 YUV444/RGB video, only 8-bits is supported as defined by HDMI 2.0 spec due to bandwidth limitation.

### Table A-2: Tested Video Resolutions for YCbCr 4:2:2 at 12 Bits/component

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Horizontal</th>
<th>Vertical</th>
<th>Frame Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Total</td>
<td>Active</td>
<td>Total</td>
</tr>
<tr>
<td>1080i50</td>
<td>2640</td>
<td>1920</td>
<td>1125</td>
</tr>
<tr>
<td>1080i60</td>
<td>2200</td>
<td>1920</td>
<td>1125</td>
</tr>
<tr>
<td>480p60</td>
<td>858</td>
<td>720</td>
<td>525</td>
</tr>
<tr>
<td>576p50</td>
<td>864</td>
<td>720</td>
<td>625</td>
</tr>
<tr>
<td>720p50</td>
<td>1980</td>
<td>1280</td>
<td>750</td>
</tr>
<tr>
<td>720p60</td>
<td>1650</td>
<td>1280</td>
<td>750</td>
</tr>
<tr>
<td>1080p24</td>
<td>2750</td>
<td>1920</td>
<td>1125</td>
</tr>
<tr>
<td>1080p25</td>
<td>2640</td>
<td>1920</td>
<td>1125</td>
</tr>
<tr>
<td>1080p30</td>
<td>2200</td>
<td>1920</td>
<td>1125</td>
</tr>
<tr>
<td>1080p50</td>
<td>2640</td>
<td>1920</td>
<td>1125</td>
</tr>
<tr>
<td>1080p60</td>
<td>2200</td>
<td>1920</td>
<td>1125</td>
</tr>
</tbody>
</table>
### Table A-2: Tested Video Resolutions for YCbCr 4:2:0 at 12 Bits/component

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Horizontal</th>
<th>Vertical</th>
<th>Frame Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Total</td>
<td>Active</td>
<td>Total</td>
</tr>
<tr>
<td>2160p24</td>
<td>5500</td>
<td>3840</td>
<td>2250</td>
</tr>
<tr>
<td>2160p25</td>
<td>5280</td>
<td>3840</td>
<td>2250</td>
</tr>
<tr>
<td>2160p30</td>
<td>4400</td>
<td>3840</td>
<td>2250</td>
</tr>
<tr>
<td>vgap60</td>
<td>800</td>
<td>640</td>
<td>525</td>
</tr>
<tr>
<td>svgap60</td>
<td>1056</td>
<td>800</td>
<td>628</td>
</tr>
<tr>
<td>wxgap60</td>
<td>1440</td>
<td>1280</td>
<td>790</td>
</tr>
<tr>
<td>wxga+p60</td>
<td>1792</td>
<td>1366</td>
<td>798</td>
</tr>
<tr>
<td>ugap60</td>
<td>2160</td>
<td>1600</td>
<td>1250</td>
</tr>
<tr>
<td>wuxgap60</td>
<td>2592</td>
<td>1920</td>
<td>1245</td>
</tr>
<tr>
<td>wsxgap60</td>
<td>2240</td>
<td>1680</td>
<td>1089</td>
</tr>
</tbody>
</table>

### Table A-3: Tested Video Resolutions for YCbCr 4:2:2 at 12 Bits/component

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Horizontal</th>
<th>Vertical</th>
<th>Frame Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Total</td>
<td>Active</td>
<td>Total</td>
</tr>
<tr>
<td>2160p60</td>
<td>4400</td>
<td>3840</td>
<td>2250</td>
</tr>
</tbody>
</table>
Appendix B

Migrating and Upgrading

This appendix contains information about upgrading to a more recent version of the IP core.

Upgrading in the Vivado Design Suite

This section provides information about any changes to the user logic or port designations between core versions.

Parameter Changes

Table lists the parameter changes across the core versions.

Table B-1: GUI Parameters Changes across Versions

<table>
<thead>
<tr>
<th>GUI Parameter</th>
<th>v2.0</th>
<th>v3.0</th>
<th>v3.1</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Topology</td>
<td>Not Applicable</td>
<td>New</td>
<td>No Change</td>
<td>New options in v3.0 for example design configuration. Refer to &quot;Customizing and Generating the Subsystem&quot; section for details.</td>
</tr>
<tr>
<td>Tx PLL Type</td>
<td>Not Applicable</td>
<td>New</td>
<td>No Change</td>
<td></td>
</tr>
<tr>
<td>Rx PLL Type</td>
<td>Not Applicable</td>
<td>New</td>
<td>No Change</td>
<td></td>
</tr>
<tr>
<td>Include NIDRU</td>
<td>Not Applicable</td>
<td>New</td>
<td>No Change</td>
<td></td>
</tr>
<tr>
<td>Axilite Frequency</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
<td>New</td>
<td>New option in v3.1 for example design configuration. Refer to &quot;Customizing and Generating the Subsystem&quot; section for details.</td>
</tr>
</tbody>
</table>

Notes:
1. Not Applicable: GUI option is not available in this version
2. No Change: GUI option remain as in previous version
3. New: New GUI option added in this version

Port Changes

Link Data port width has changed to be configurable based on pixel per clock selection. The port width is reduced to 20 bits from the original 40 bits when user selects 2 pixels per clock.
The Link Data port width remains the default 40 bits for 4 pixels per clock.

**Other Changes**

There are no other changes.

**Migration Notes**

When migrating from version 2016.3 or earlier, make note of the following:

- Hot Plug Detect Active has been added to HDMI 1.4/2.0 Transmitter Subsystem GUI.
  Choose High in the Example Design (according to board design).
- Hot Plug Detect Active has been added to HDMI 1.4/2.0 Receiver Subsystem GUI.
  Choose Low in Example Design (according to board design).
- Cable Detect Active has been added to HDMI 1.4/2.0 Receiver Subsystem GUI.
  Choose Low in Example Design (according to board design).
- HDCP 1.4/2.2 is enabled by default in Example Design application software.
  Removed UART option to Enable HDCP 1.4 or HDCP 2.2.
- Auto switching has been added to the Example Design Application software.
  You do not need to choose HDCP 1.4 or HDCP 2.2 from UART. A corresponding HDCP is selected according to the capability of connected source/sink. If the device support both HDCP 1.4 and HDCP 2.2, the priority is given to HDCP 2.2.
- HDCP repeater feature has been added.
  You can enabled/disable it by selecting "h" from UART menu.
- System log is moved from direct UART printout to event log.
  You can display the event log by selecting "z" from UART menu.
Appendix C

Debugging

This appendix includes details about resources available on the Xilinx Support website and debugging tools.

**TIP:** If the IP generation halts with an error, there might be a license issue. See License Checkers in Chapter 1 for more details.

---

Finding Help on Xilinx.com

To help in the design and debug process when using the HDMI 1.4/2.0 Transmitter Subsystem, the Xilinx Support web page contains key resources such as product documentation, release notes, answer records, information about known issues, and links for obtaining further product support.

**Documentation**

This product guide is the main document associated with the HDMI 1.4/2.0 Transmitter Subsystem. This guide, along with documentation related to all products that aid in the design process, can be found on the Xilinx Support web page or by using the Xilinx Documentation Navigator.

Download the Xilinx Documentation Navigator from the Downloads page. For more information about this tool and the features available, open the online help after installation.

**Answer Records**

Answer Records include information about commonly encountered problems, helpful information on how to resolve these problems, and any known issues with a Xilinx product. Answer Records are created and maintained daily ensuring that users have access to the most accurate information available.

Answer Records for this subsystem can be located by using the Search Support box on the main Xilinx support web page. To maximize your search results, use proper keywords such as
Appendix C: Debugging

- Product name
- Tool message(s)
- Summary of the issue encountered

A filter search is available after results are returned to further target the results.

Master Answer Record for the HDMI 1.4/2.0 Transmitter Subsystem

AR: 6591

Technical Support

Xilinx provides technical support at the Xilinx Support web page for this LogiCORE™ IP product when used as described in the product documentation. Xilinx cannot guarantee timing, functionality, or support if you do any of the following:

- Implement the solution in devices that are not defined in the documentation.
- Customize the solution beyond that allowed in the product documentation.
- Change any section of the design labeled DO NOT MODIFY.

To contact Xilinx Technical Support, navigate to the Xilinx Support web page.

Additional support can be found at the Xilinx Video - Community Forums.

Debug Tools

Tools are available to address HDMI 1.4/2.0 Transmitter Subsystem design issues. It is important to know which tools are useful for debugging various situations.

Vivado Design Suite Debug Feature

The Vivado® Design Suite debug feature inserts logic analyzer and virtual I/O cores directly into your design. The debug feature also allows you to set trigger conditions to capture application and integrated block port signals in hardware. Captured signals can then be analyzed. This feature in the Vivado IDE is used for logic debugging and validation of a design running in Xilinx devices.

The Vivado logic analyzer is used with the logic debug IP cores, including:

- ILA 2.0 (and later versions)
- VIO 2.0 (and later versions)

See the Vivado Design Suite User Guide: Programming and Debugging (UG908) [Ref 21].
Reference Boards

Various Xilinx development boards support the HDMI 1.4/2.0 Transmitter Subsystem. These boards can be used to prototype designs and establish that the subsystem can communicate with the system.

- 7 series FPGA evaluation board
  - KC705
- UltraScale FPGA evaluation board
  - KCU105
- Zynq-7000 SoC evaluation board
  - ZC706
- UltraScale+ FPGA evaluation board
  - ZCU102
  - ZCU104
  - ZCU106
  - VCU118

Hardware Debug

Hardware issues can range from link bring-up to problems seen after hours of testing. This section provides debug steps for common issues. The Vivado debug feature is a valuable resource to use in hardware debug. The signal names mentioned in the following individual sections can be probed using the debug feature for debugging the specific problems.

General Checks

- Ensure that all the timing constraints and all other constraints were met during implementation.
- Ensure that all clock sources are active and clean.
- If using MMCMs in the design, ensure that all MMCMs have obtained lock by monitoring the locked port.
- If your outputs go to 0, check your licensing.
  - User LEDs (KC705/KCU105/ZC706/ZCU102/ZCU104/ZCU106/VCU118)
  - LED0 - HDMI TX subsystem lock (when HDMI Example Design is used)
  - Use debug port to check if there are link data driven to Video PHY Controller core.
- Refer to the Debugging Appendix in Video PHY Controller LogiCORE IP Product Guide (PG230) [Ref 24], and ensure there is no problem with clocking issues.

---

**In-system Debug**

For in-system debugging assistance, relevant information is brought to UART for you to verify before checking the hardware signals.

1. Press 'I' to check the system information.
2. Press 'z' to check the event log.

   Table C-1 shows two examples of system flow event logs.
3. Press 'e' to check the EDID.

In this release, application software will read and parse sink's EDID to know sink's capability. However, current application doesn't block the user to set certain video formats although it is not supported by the sink. Instead, a "warning" message will be prompted to indicating the sink's limitation when user presses 'e'.

In this release, for the EDID parsing feature, 3 VERBOSITY level are defined. User may set it according to their requirements. It is accessible from video_common library, in xvidc_cea861.h.

<table>
<thead>
<tr>
<th>Table C-1: System Flow Event Log</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>At system start-up</strong></td>
<td><strong>While changing video stream from UART Menu</strong></td>
</tr>
<tr>
<td>VPHY log</td>
<td>VPHY log</td>
</tr>
<tr>
<td>------</td>
<td>------</td>
</tr>
<tr>
<td>GT init start</td>
<td>TX frequency event</td>
</tr>
<tr>
<td>GT init done</td>
<td>QPLL lost lock</td>
</tr>
<tr>
<td>TX frequency event</td>
<td>TX frequency event</td>
</tr>
<tr>
<td>TX timer event</td>
<td>TX timer event</td>
</tr>
<tr>
<td>TX MMCM reconfig done</td>
<td>TX MMCM reconfig done</td>
</tr>
<tr>
<td>QPLL reconfig done</td>
<td>QPLL reconfig done</td>
</tr>
<tr>
<td>GT TX reconfig start</td>
<td>GT TX reconfig start</td>
</tr>
<tr>
<td>GT TX reconfig done</td>
<td>GT TX reconfig done</td>
</tr>
<tr>
<td>TX MMCM lock</td>
<td>TX MMCM lock</td>
</tr>
<tr>
<td>QPLL lock</td>
<td>QPLL lock</td>
</tr>
<tr>
<td>TX reset done</td>
<td>TX reset done</td>
</tr>
<tr>
<td>TX alignment done</td>
<td>TX alignment done</td>
</tr>
<tr>
<td>HDMI TX log</td>
<td>HDMI TX log</td>
</tr>
<tr>
<td>------</td>
<td>------</td>
</tr>
<tr>
<td>Initializing HDMI TX core....</td>
<td>TX Set Stream, with TMDS (128)</td>
</tr>
<tr>
<td>Initializing VTC core....</td>
<td>TX Stream is Down</td>
</tr>
<tr>
<td>Reset HDMI TX Subsystem....</td>
<td>TX Audio Unmuted</td>
</tr>
<tr>
<td>TX cable is connected....</td>
<td>TX Stream is Up</td>
</tr>
<tr>
<td>TX Stream is Down</td>
<td></td>
</tr>
<tr>
<td>TX Set Stream, with TMDS (32)</td>
<td></td>
</tr>
<tr>
<td>TX Audio Unmuted</td>
<td></td>
</tr>
<tr>
<td>TX Stream is Up</td>
<td></td>
</tr>
</tbody>
</table>
#define XVIDC_EDID_VERBOSITY 0

where

<table>
<thead>
<tr>
<th>XVIDC_EDID_VERBOSITY</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (Default)</td>
<td>Read and parse the EDID</td>
</tr>
<tr>
<td></td>
<td>No display of capability</td>
</tr>
<tr>
<td>1</td>
<td>Read and parse the EDID</td>
</tr>
<tr>
<td></td>
<td>Display of Sink’s basic capability</td>
</tr>
<tr>
<td>2</td>
<td>Read and parse the EDID</td>
</tr>
<tr>
<td></td>
<td>Display of sink’s full capability</td>
</tr>
</tbody>
</table>

**IMPORTANT:** In Example design running on MicroBlaze, limited BRAM resources are allocated to store software binary. If user enables the XVIDC_EDID_VERBOSITY to higher level, which will consume more software resources, user may need to increase the BRAM allocation. Otherwise, you may experience system instability such as UART hangs etc.

4. Press ‘h’ to check HDCP status.

   **Note:** HDCP Debug Menu is not enabled by default. You can enable it by setting it in xhdmi_example.h

   /* Enabling this will enable HDCP Debug menu */
   #define HDCP_DEBUG_MENU_EN 1

   **Note:** You must check the software size so that it doesn’t exceed the BRAM allocated.

5. It is recommended that you follow the below steps while changing the video mode through the HDMI Application during TX-Only mode (as a color bar or any supported video pattern available) in a Pass-through topology or TX-only topology example design:

   a. Select intended resolution from the menu (by default, the video mode color space is set to RGB, frame rate is set to 60Hz (except, 576p and 576i which will be 50Hz, and the 3840x2160p (SB) which will be 30Hz and the color depth is set to 8 BPC)

   b. Select the intended frame rate from the menu (this will only change the frame rate on top of the video mode set in (1))

   c. Select the intended color space from the menu (this will only change the color space on top of the video mode set in (2))

   d. Select the intended color depth from the menu (this will only change the color depth on top of the video mode set in (3))

   **Note:** Color depth option should be set at the last step.
Interface Debug

AXI4-Lite Interfaces

Read from a register that does not have all 0s as a default to verify that the interface is functional. Output \texttt{s\_axi\_arready} asserts when the read address is valid, and output \texttt{s\_axi\_rvalid} asserts when the read data/response is valid. If the interface is unresponsive, ensure that the following conditions are met:

- The \texttt{s\_axi\_aclk} and \texttt{aclk} inputs are connected and toggling.
- The interface is not being held in reset, and \texttt{s\_axi\_areset} is an active-Low reset.
- The interface is enabled, and \texttt{s\_axi\_aclken} is active-High (if used).
- The main subsystem clocks are toggling and that the enables are also asserted.
- Add AXI4 Lite interface to ILA, and analysis data captured when triggering at \texttt{s\_axi\_rvalid}.

AXI4-Stream Interfaces

If data is not being transmitted or received, check the following conditions:

- If received \texttt{<interface\_name>\_tready} is stuck low, the subsystem cannot send data. Check if there is an issue at the AXI4 Stream Slave.
- Check that the \texttt{aclk} inputs are connected and toggling.
- Check that the AXI4-Stream waveforms are being followed.
- Check subsystem configuration.

AXI4-Stream Audio Interface

To ensure that the audio is working in HDMI 1.4/2.0 Transmitter Subsystem, the AXI4-Stream must be constructed as described below.

The HDMI 1.4/2.0 Transmitter Subsystem supports up to 8 audio channels. The audio data is transmitted through AXI4-Stream audio interface, which is a customized AXI4-Stream protocol that is used to send audio samples with sideband signals defined in AES3 specification.

The sub-frame format for audio sample is shown as below.

```
<table>
<thead>
<tr>
<th>0</th>
<th>3</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>24-bit audio sample word</td>
<td>MSB</td>
<td>User data bit</td>
</tr>
<tr>
<td>LSB</td>
<td>Validity bit</td>
<td>Channel status bit</td>
</tr>
<tr>
<td>Preamble</td>
<td></td>
<td>Parity bit</td>
</tr>
</tbody>
</table>
```
A frame is uniquely composed of two sub-frames. The first sub-frame normally starts with preamble "X", and the second sub-frame always starts with preamble “Y”. However, every 192 frames form one “Audio Block”. And the first sub-frame in each “Audio Block” starts with a preamble “Z”. An illustration is shown below.

In the case of more than 2 channels, every 2 channels are considered as a single AES3 audio block. For example, using 8 audio channels, one audio block consists of 192*8 audio samples. For the first 8 samples of an audio block, the preamble for audio ch0, ch2, ch4, ch6 are “Z”. In remaining part of audio block, the preamble for audio ch0, ch2, ch4, ch6 are “X”. The preambles for audio ch1, ch3, ch5, ch7 are always “Y” through out of the whole audio block. An illustration of 8 channel audio is shown below.

If 8 channel audio is enabled in your design, and only N Channels (where N is less than 8, i.e 6) out of 8 channels carry valid audio data. For the unused channels, you must pack the audio data with zeros and the sub-frame data allocation follows as per illustrated above.
Application Software Development

Device Drivers

The HDMI 1.4/2.0 Transmitter Subsystem driver abstracts the included supporting elements and provides you with an API for control. The API can be easily integrated into your application thereby providing an out-of-the-box solution.

The subsystem driver is a bare-metal driver, which provides an abstracted view of the feature set provided by each sub-core. It dynamically manages the data and control flow through the processing elements, based on the input/output stream configuration set at run time. Internally, it relies on sub-core drivers to configure the sub-core IP blocks.

Architecture

The subsystem driver provides an easy-to-use, well-defined API to help integrate the subsystem in an application without having to understand the underlying complexity of configuring each and every sub-core.

The subsystem driver consists of the following:

- **Subsystem layer**: Queries exported hardware to determine the subsystem hardware configuration and pull-in sub-core drivers, at build time. It abstracts sub-core drivers, which interface with hardware at register level, into a set of functional APIs. The subsystem driver uses these APIs to dynamically manage the data flow through processing elements.

- **Sub-core drivers**: Every included sub-core has a driver associated with it that provides APIs to interface with the core hardware.

*Figure D-1* shows the HDMI 1.4/2.0 Transmitter Subsystem architecture.
Appendix D: Application Software Development

The HDMI 1.4/2.0 Transmitter Subsystem is a MAC subsystem which works with a Video PHY Controller (PHY) to create a video connectivity system. The HDMI 1.4/2.0 Transmitter Subsystem is tightly coupled with the Xilinx Video PHY Controller, which itself is independent and offers flexible architecture with multiple-protocol support. Both MAC and PHY are dynamically programmable through the AXI4-Lite interface.

**Figure D-1:** Subsystem Driver Architecture

The HDMI 1.4/2.0 Transmitter Subsystem is a MAC subsystem which works with a Video PHY Controller (PHY) to create a video connectivity system. The HDMI 1.4/2.0 Transmitter Subsystem is tightly coupled with the Xilinx Video PHY Controller, which itself is independent and offers flexible architecture with multiple-protocol support. Both MAC and PHY are dynamically programmable through the AXI4-Lite interface.

**Figure D-2:** MAC Interfaces with PHY
Usage

The HDMI 1.4/2.0 Transmitter Subsystem provides a set of API functions for application code to use. On top of that, when HDMI 1.4/2.0 Transmitter Subsystem hardware interrupts are generated, the subsystem driver is invoked to configure the system accordingly. HDMI 1.4/2.0 Transmitter Subsystem provides callback structure to hook up your own callback functions.

Ensure that the video stream has started. Then, valid AUX data and audio data can be inserted after the video is locked. However, because the application knows what video format will be sent and what audio format will be embedded. With this information, the ACR number can be calculated and set before audio stream is ready to be sent.

In the following sections, only HDMI related modules are covered. The user application needs to take care of system peripheral, such as timer, UART, external system clock generator, etc.

**Note:** Because the HDMI 1.4/2.0 Transmitter Subsystem and HDMI 1.4/2.0 Receiver Subsystem have many common features, HDMI Common Library is introduced for this purpose to define common data structures which can be shared by both subsystems.

### HDMI TX Subsystem Flow

HDMI TX Subsystem in general responses to the following two events:

- Hot-plug signal (HPD) from the sink device
- Software user application to indicate a change of video stream (e.g. change of video resolution)

The main program flow is shown in Figure D-3. At execution, the software application initializes the HDMI TX Subsystem IP and registers the callback functions in the provided hooks.
Application Integration

Figure D-4 shows an example code on how an HDMI 1.4/2.0 Transmitter Subsystem can be used in your application.

Figure D-4: TX Flow
To integrate and use the HDMI 1.4/2.0 Transmitter Subsystem driver in your application, the following steps must be followed:

1. Include the subsystem header file `xv_hdmitxss.h` that defines the subsystem object.

2. Declare and allocate space for subsystem instance in your application code. For example:
   ```c
   XV_HdmiTxSs HdmiTxSs;
   XV_HdmiTxSs_Config *XV_HdmiTxSs_ConfigPtr;
   ```

3. In the subsystem driver instance, there is a metadata structure to store the subsystem hardware configuration. Declare a pointer variable in the application code to point to the instance:
   ```c
   XV_HdmiTxSs_Config *XV_HdmiTxSs_ConfigPtr;
   ```

4. For each subsystem instance, the data structures declared in steps 2 and 3 need to be initialized based on its hardware configuration, which is passed through metadata structure from `xparameters.h` uniquely identified by device ID.
Appendix D: Application Software Development

To initialize the subsystem, call the following two API functions:

```c
XV_HdmiTxSs_Config* XV_HdmiTxSs.LookupConfig(u32 DeviceId);
int XV_HdmiTxSs_CfgInitialize(XV_HdmiTxSs *InstancePtr,
        XV_HdmiTxSs_Config *CfgPtr,
        u32 EffectiveAddr);
```

The Device ID can be found in `xparameters.h`:

` XPAR_[HDMI TX Subsystem Instance Name in IPI]_DEVICE_ID`

5. Each interrupt source has an associated ISR defined in the subsystem. Register the ISR with the system interrupt controller and enable the interrupt.

```c
int XIntc_Connect(XIntc *InstancePtr,
        u8 Id,
        XInterruptHandler Handler,
        void *CallBackRef);
void XIntc_Enable(XIntc *InstancePtr,
        u8 Id);
```

Where ID can be found in `xparameters.h`.

**HDCP TX Overview**

The HDMI 1.4/2.0 Transmitter Subsystem driver is responsible for combining HDCP 1.4 and HDCP 2.2 drivers APIs into a single common API for use by the user level application. The common HDCP driver API is able to handle the following HDCP configurations: HDCP 1.4 only, HDCP 2.2 only, and both. When both protocols are enabled, the common HDCP driver ensures that only one is active at any given time.

**HDCP TX Driver Integration**

This section describes the steps required to initialize and run the HDCP TX. The application should call the functions roughly in the order specified to ensure that the driver operates properly. When only a single HDCP protocol is enabled, either 1.4 or 2.2, a subset of the function calls might be needed.

1. Load the HDCP production keys into the HDMI subsystem. This function needs to be called for each key that is loaded. If HDCP 1.4 and 2.2 are enabled all the keys must be loaded, otherwise a subset of the keys are loaded. Note that the byte arrays used to store the key octet strings for HDCP are defined in big endian byte order.
   - `XV_HdmiTxSs_HdcpSetKey`
   - `XV_HDMITXSS_KEY_HDCP14`
   - `XV_HDMITXSS_KEY_HDCP22 LC128` (128-bit DCP Licensed Constant)
**IMPORTANT:** In an HDCP enabled system, after the key management block is successfully initialized, a bit is set to block reading out the key again. The bit remains set until the FPGA is reprogrammed. Therefore, the keys can only be read ONCE during initialization.

2. Initialize the HDMI 1.4/2.0 Transmitter Subsystem driver after the HDCP keys have been loaded. Initializing the subsystem begins the HDCP 1.4/2.2 drivers internally.

3. Connect the HDCP interrupt handlers to the interrupt controller interrupt ID:
   - XV_HdmiTxSS_HdcpIntrHandler
   - XV_HdmiTxSS_HdcpTimerIntrHandler
   - XV_HdmiTxSS_Hdcp22TimerIntrHandler

4. Set the HDCP user callback functions. These callback functions are used to hook into HDCP state machine and allow the user to take action at various stages of the protocol. If there is no use for the callback at the application level, then the callback can be left undefined.
   - XV_HdmiTxSs_SetCallback
     - XV_HDMITXSS_HANDLER_HDCP_AUTHENTICATED
     - XV_HDMITXSS_HANDLER_HDCP_DOWNSTREAM_TOPOLOGYAVAILABLE
     - XV_HDMITXSS_HANDLER_HDCP_UNAUTHENTICATED

5. Execute the poll function to run the HDCP state machine. This function checks to see which HDCP protocol is enabled, and then execute only the active protocol. The call to this function can be inserted in the main loop of the user application and should execute continuously. Because the HDCP TX state machine is run using this poll function, it is important to ensure that this function is given adequate CPU runtime, especially during authentication attempts.
   - XV_HdmiTxSs_HdcpPoll

6. Optionally, set the HDCP protocol capability. The default option is both, which means that if both HDCP 1.4 and HDCP 2.2 are included as part of the HDMI subsystem, the transmitter tries to authenticate with either protocol based on the capability of the downstream device. Note that HDCP 2.2 is given priority over HDCP 1.4. If the capability is set to none, then authentication attempts are ignored.
   - XV_HdmiTxSs_HdcpSetCapability
     - XV_HDMITXSS_HDCP_NONE
     - XV_HDMITXSS_HDCP_14
     - XV_HDMITXSS_HDCP_22
     - XV_HDMITXSS_HDCP_BOTH

7. Authentication should be initiated only after the transmission of video to the downstream device. It is the responsibility of the user application to determine when to
issue authentication requests. Authentication requests are commonly initiated for the following events: stream-up, and HPD toggle. In the event that the first authentication request is not successful, the user application can issue another authentication request.

- XV_HdmiTxSs_HdcpPushEvent
  - XV_HDMITXSS_HDCP_AUTHENTICATE_EVT

8. Check the status of authentication. These checks could be performed before issuing authentication requests.

- XV_HdmiTxSs_HdcpIsAuthenticated
- XV_HdmiTxSs_HdcpIsInProgress

9. When authentication is successful, the application is allowed to enable encryption. The enablement of encryption can happen any time after successful authentication and is the responsibility of the application to manage. For example, an application might decide to enable encryption only for restricted content, but disable encryption for standard content.

- XV_HdmiTxSs_HdcpEnableEncryption
- XV_HdmiTxSs_HdcpDisableEncryption

10. Check the status of the cipher encryption. This is the instantaneous encryption status of the cipher and can change between subsequent frames. For repeater or pass-through applications, special care must be taken to block downstream content if the upstream interface is encrypted while the downstream interface is not encrypted.

- XV_HdmiTxSs_HdcpIsEncrypted

11. Check the overall HDCP protocol status and log data. You can also set the level of detail for log information reported.

- XV_HdmiTxSs_HdcpInfo
- XV_HdmiTxSs_SetInfoDetail

**Integrate Video PHY Controller Driver for HDMI TX Subsystem Usage**

Because the HDMI 1.4/2.0 Transmitter Subsystem is closely coupled with the Video PHY Controller, the following example code demonstrates how a Video PHY Controller can be used in your application.
Appendix D: Application Software Development

To integrate and use the Video PHY Controller for HDMI 1.4/2.0 Transmitter Subsystem in the application code, the following steps must be followed:

1. Include the subsystem header file `xvphy.h` that defines the subsystem object.
2. Declare and allocate space for a Video PHY Controller instance in your application code.

Example:

```c
XVphy Vphy; /* VPHY structure */
XVphy_Config *XVphyCfgPtr;
// Initialize Video PHY
XVphyCfgPtr = XVphy_LockupConfig(XPAR_VIDEO_PHY_CONTROLLER_0_DEVICE_ID);
if (XVphyCfgPtr == NULL) {
    print("Video PHY device not found\n\r");
    return XST_FAILURE;
}

/* Initialize HDMI VPHY */
Status = XVphy_HdmInitialize(&Vphy,
    XVphyCfgPtr, XPAR_CPU_CORE_CLOCK_FREQ_HZ);
if (Status != XST_SUCCESS) {
    print("HDMI VPHY initialization error\n\r");
    return XST_FAILURE;
}

/* Register VPHY Interrupt Handler */
Status = XIntc_Connect(&Intc,
    XPAR_MICROBLAZE_SS_AXI_INTR_0_VID_PHY_CONTROLLER_0_IRQ_INTR,
    (XInterruptHandler)XVphy_InterruptHandler,
    (void *)&Vphy);
if (Status != XST_SUCCESS) {
    print("HDMI VPHY Interrupt V avg ID not found!\n\r");
    return XST_FAILURE;
}

/* Enable VPHY Interrupt */
XIntc_Enable(&Intc,
    XPAR_MICROBLAZE_SS_AXI_INTR_0_VID_PHY_CONTROLLER_0_IRQ_INTR);
```

Figure D-5: Application Example Code

To integrate and use the Video PHY Controller for HDMI 1.4/2.0 Transmitter Subsystem in the application code, the following steps must be followed:

1. Include the subsystem header file `xvphy.h` that defines the subsystem object.
2. Declare and allocate space for a Video PHY Controller instance in your application code.

Example:

```c
XVphy Vphy;
```
3. In the Video PHY Controller instance, there is a metadata structure to store its hardware configuration. Declare a pointer variable in the application code to point to the instance:

```c
XVphy_Config *XVphyCfgPtr;
```
4. For each Video PHY Controller instance, the above data structure needs to be initialized based on its hardware configuration, which is passed through meta-structure from `xparameters.h` uniquely identified by device ID.

To initialize the Video PHY Controller, call the following two API functions:

```c
XVphy_Config *XVphy_LookupConfig(u16 DeviceId);
u32 XVphy_HdmiInitialize(XVphy *InstancePtr,
    u8 QuadId,
    XVphy_Config *CfgPtr,
    u32 SystemFrequency);
```

The Device ID can be found in `xparameters.h`:

```
 XPAR_[Video PHY Controller Instance Name in IPI]_DEVICE_ID
```

Similarly, `SystemFrequency` is the system frequency, which can also be found in `xparameters.h`

**Note:**
- Xilinx recommends initializing the Video PHY controller after the HDMI 1.4/2.0 Transmitter Subsystem initialization is completed.
- Registering the Video PHY Controller interrupts are part of system application integration. Steps are shown in the previous section and not repeated here.

**Interrupts**

All interrupts generated by the HDMI 1.4/2.0 Transmitter Subsystem are listed here:

1. **HPD** – Peripheral I/O to detect HDMI cable 5.0V signal
   - **Rising edge** – If HPD disconnect interrupt has happened and HPD line is asserted for more than 10 ms.
   - **Falling edge** – If HPD line is de-asserted for more than 100 ms.

   A pulse occurred on the HPD line with a pulse width between 50 and 99 ms.

2. **Link Ready** – Every time when Video PHY Controller is reconfigured, the `link_clk` is regenerated. An HDMI TX sub-core register bit (link status bit) reflects the change of `link_clk` status. When stable `link_clk` is detected, it is set to 1. When `link_clk` becomes unstable, it is set to 0. The Link Ready is an interrupt to detect the change of the link status bit.
   - **Rising edge** – Link is up
   - **Falling edge** – Link is down

3. **Vertical Sync** – This is to reflect the change of HDMI TX sub-core `vsync` input signal in its video interface bus.
a. **Rising edge** – Vertical Sync is detected

4. Video Bridge Unlocked - The AXI4-Stream to Video Out Bridge lost lock with the incoming AXI4 Video Stream

5. HDCP1.4 Interrupt (only available when HDCP 1.4 is enabled in hardware)

6. HDCP 1.4 Timer Interrupt (only available when HDCP 1.4 is enabled in hardware)

7. HDCP 2.2 Timer Interrupt (only available when HDCP 2.2 is enabled in hardware)

**Table D-1:** Mapping between Interrupt Sources and Application Callback Functions

<table>
<thead>
<tr>
<th>Interrupts</th>
<th>Callback</th>
</tr>
</thead>
<tbody>
<tr>
<td>HPD</td>
<td>XV_HDMITXSS_HANDLER_CONNECT, XV_HDMITXSS_HANDLER_TOGGLE</td>
</tr>
<tr>
<td>Link Ready</td>
<td>XV_HDMITXSS_HANDLER_STREAM_UP, XV_HDMITXSS_HANDLER_STREAM_DOWN</td>
</tr>
<tr>
<td><strong>Note:</strong> It is edge triggered.</td>
<td></td>
</tr>
<tr>
<td>Vertical Sync</td>
<td>XV_HDMITXSS_HANDLER_VS</td>
</tr>
<tr>
<td>Video Bridge Unlocked</td>
<td>XV_HDMITXSS_HANDLER_BRDGUNLOCK</td>
</tr>
<tr>
<td>HDCP 1.4 Interrupt</td>
<td>XV_HDMITXSS_HANDLER_HDCP_AUTHENTICATE</td>
</tr>
<tr>
<td>HDCP 1.4 Timer Interrupt</td>
<td>XV_HDMITXSS_HANDLER_HDCP_DOWNSTREAM_TOPOLOGY_AVAILABLE</td>
</tr>
<tr>
<td>HDCP 2.2 Timer Interrupt</td>
<td>XV_HDMITXSS_HANDLER_HDCP_UNAUTHENTICATED</td>
</tr>
<tr>
<td><strong>Note:</strong> This callback function is not directly mapped to any interrupt source. Instead it is executed when the HDCP authentication state machine has reached the authenticated state.</td>
<td></td>
</tr>
</tbody>
</table>

**Application Callback Functions**

Subsystem driver provides a mechanism for the application to register a user-defined function that gets called within an interrupt context.

Callback functions defined in the application code must be registered with provided handlers, using the following defined API:

```c
int XV_HdmiTxSs_SetCallback(XV_HdmiTxSs *InstancePtr, 
                             u32 HandlerType, 
                             void *CallbackFuncPtr, 
                             void *CallbackRef);
```

Available handlers are defined in `xv_hdmitxss.h`.
• XV_HDMITXSS_HANDLER_CONNECT
• XV_HDMITXSS_HANDLER_VS
• XV_HDMITXSS_HANDLER_STREAM_UP
• XV_HDMITXSS_HANDLER_STREAM_DOWN
• XV_HDMITXSS_HANDLER_HDCP_AUTHENTICATE

**XV_HDMITXSS_HANDLER_CONNECT**

This interrupt is triggered every time when an HDMI TX cable connection or disconnection (HPD level transition) occurs.

The callback function needs to perform the following:

1. Check if the event is cable connected or cable disconnected:

   ```c
   XV_HdmiTxSs *HdmiTxSsPtr = (XV_HdmiTxSs *)CallbackRef;
   HdmiTxSsPtr->IsStreamConnected
   1 - Connected
   0 - Disconnected
   ```

2. Enable or disable the differential input clock buffer depending on if cable connection or disconnection occurs, respectively.

   ```c
   void XVphy_IBufDsEnable(XVphy *InstancePtr,
                           u8 QuadId,
                           XVphy_DirectionType Dir,
                           u8 Enable);
   ```

3. Detect if the HDMI sink connected is HDMI 2.0 capable and if cable is connected.

   ```c
   int XV_HdmiTxSs_DetectHdmi20(XV_HdmiTxSs *InstancePtr);
   ```

4. Now, the HDMI sink has been detected, retrieve the sink EDID information, and store it in a local buffer (256 bytes) using the following API:

   ```c
   int XV_HdmiTxSs_ReadEdid(XV_HdmiTxSs *InstancePtr,
                            u8 *Buffer);
   ```

**XV_HDMITXSS_HANDLER_VS**

This interrupt is triggered every time when an input video stream vertical sync is detected by the HDMI TX sub-core.

The callback function can be used to construct and send InfoFrames to the Sink.

```c
void XV_HdmiTxSs_SendAuxInfoframe(XV_HdmiTxSs *InstancePtr,
                                  void *Aux);
```
**XV_HDMITXSS_HANDLER_STREAM_UP**

This interrupt is triggered every time the Video PHY Controller is reconfigured and the output clock is stabilized and ready for HDMI 1.4/2.0 Transmitter Subsystem to transmit video stream.

The callback function needs to perform the following:

1. If a HDMI Retimer or equalizer is used in the system, configure the Retimer with the correct setting based on the required line rate.
2. Enable TX TMDS Clock by calling Video PHY Controller API:
   ```c
   void XVphy_Clkout1OBufTdsEnable(XVphy *InstancePtr,
                                   XVphy_DirectionType Dir,
                                   u8 Enable);
   ```
3. Set HDMI 1.4/2.0 Transmitter Subsystem Sampling Rate with the Video PHY Controller TX Sampling Rate.
   ```c
   void XV_HdmiTxSs_SetSamplingRate(XV_HdmiTxSs *InstancePtr,
                                   u8 SamplingRate);
   ```

**XV_HDMITXSS_HANDLER_STREAM_DOWN**

This interrupt is triggered every time the Video PHY Controller is reconfigured and the output clock is not stable for HDMI 1.4/2.0 Transmitter Subsystem to stream video.

The callback function might disable TX TMDS Clock by calling Video PHY Controller API:

```c
void XVphy_Clkout1OBufTdsEnable(XVphy *InstancePtr,
                                   XVphy_DirectionType Dir,
                                   u8 Enable);
```

**XV_HDMITXSS_HANDLER_HDCP_AUTHENTICATE**

This interrupt is triggered when a cable is connected, a HDCP 1.4 or HDCP 2.2 is enabled, and HDCP is entering an authentication state.

The callback function needs to perform the following:

1. Enable HDCP encryption.
2. Signal to the system that authentication has successfully completed.

**Video PHY Controller Interrupt Handlers for HDMI 1.4/2.0 Transmitter Subsystem**

There are several interrupt handlers available in the Video PHY Controller driver to hook up with user-defined callback functions to support HDMI 1.4/2.0 Transmitter Subsystem functionality. These interrupt handlers are defined in xvphy.h:
Appendix D: Application Software Development

- XVPHY_HDMI_HANDLER_TXINIT
- XVPHY_HDMI_HANDLER_TXREADY

Callback functions need to be defined in the application code and hooked up with these interrupt handlers.

```c
void XVphy_SetHdmiCallback(XVphy *InstancePtr,
                           XVphy_HdmiHandlerType HandlerType,
                           void *CallbackFunc,
                           void *CallbackRef);
```

**XVPHY_HDMI_HANDLER_TXINIT**

This interrupt is triggered every time the Video PHY Controller detects an HDMI TX reference clock changes.

The callback function needs to initialize a reference clock change process for HDMI 1.4/2.0 Transmitter Subsystem.

```c
void XV_HdmiTxSs_RefClockChangeInit(XV_HdmiTxSs *InstancePtr);
```

**XVPHY_HDMI_HANDLER_TXREADY**

This interrupt is triggered every time the Video PHY Controller TX reset lock is done or when Video PHY Controller TX alignment is done.

The callback function can update the Video PHY ready for TX information to the application software.

Follow the steps in Chapter 5, Example Design to create an example design, which contains all the procedures implemented and can serve as a reference for integrating the HDMI 1.4/2.0 Transmitter Subsystem into your system.

**Example Use Cases**

In this section, some typical use cases are illustrated with how system reacts at run time to certain events and what is expected for you to perform. For actions expected in the callback functions, see Application Callback Functions for more information.

**Use Case 1: Cable Plug In**

HPD interrupt is received indicating Cable Connection.

- Callback function registered to XV_HDMITXSS_HANDLER_CONNECT Interrupt type is called.

**Use Case 2: Cable Plug Out**

HPD interrupt is received indicating Cable Disconnection.
• Callback function registered to `XV_HDMITXSS_HANDLER_CONNECT` Interrupt type is called.

Use Case 3: Send Infoframe

Vertical Sync (VS) interrupt is received.

• Callback function registered to `XV_HDMITXSS_HANDLER_VS` Interrupt type is called.

Use Case 4: Send Video Stream

1. Disable the Video PHY Controller TDMS clock for HDMI 1.4/2.0 Transmitter Subsystem through API:

   ```c
   XVphy_Clkout10BufTdsEnable(XVphy *InstancePtr,
                               XVphy_DirectionType Dir,
                               u8 Enable);
   
   Example:
   
   XVphy_Clkout10BufTdsEnable(VphyPtr,
                               XVPHY_DIR_TX,
                               (FALSE));
   ```

2. Set the HDMI 1.4/2.0 Transmitter Subsystem stream parameters through API:

   ```c
   u32 XV_HdmiTxSs_SetStream(XV_HdmiTxSs *InstancePtr,
                              XVidC_VideoMode VideoMode,
                              XVidC_ColorFormat ColorFormat,
                              XVidC_ColorDepth Bpc,
                              XVidC_3DInfo *Info3D);
   
   Example:
   
   TmdsClock = XV_HdmiTxSs_SetStream(HdmiTxSsPtr,
                                    VideoMode,
                                    ColorFormat,
                                    Bpc,
                                    NULL);
   ```

3. Set the Video PHY Controller TX reference clock:

   ```c
   VphyPtr->HdmiTxRefClkHz = TmdsClock;
   ```

4. Set the HDMI TX Parameter for Video PHY Controller:

   ```c
   u32 XVphy_SetHdmiTxParam(XVphy *InstancePtr,
                            u8 QuadId,
                            XVphy_ChannelId ChId,
                            XVidC_PixelsPerClock Ppc,
                            XVidC_ColorDepth Bpc,
                            XVidC_ColorFormat ColorFormat);
   
   Example:
   
   Result = XVphy_SetHdmiTxParam(VphyPtr,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
                              0,
5. Program the external clock generator to provide the Reference TMDS clocks for Video PHY Controller.

6. Video PHY Controller HDMI TX Init interrupt is received.
   - Callback function registered to XVPHY_HDMI_HANDLER_TXINIT Interrupt type is called.

7. Video PHY Controller HDMI TX Ready interrupt is received.
   - Callback function registered to XVPHY_HDMI_HANDLER_TXREADY Interrupt type is called.

8. HDMI TX Stream UP interrupt is received.
   - Callback function registered to XV_HDMITXSS_HANDLER_STREAM_UP Interrupt type is called.

**Use Case 5: Support Multiple Channels Audio**

Define: \( N = \text{Number of Audio Channel} \)

1. Change the Audio Infoframe by setting the channel count in API

   ```c
   void XV_Hdmi TxSs_SendAuxInfoframe(XV_HdmiTxSs *InstancePtr, void *AuxPtr);
   /* 2 Channel count. Audio coding type refer to stream */
   ```

2. Set HDMI TX SS audio channels using this API:

   ```c
   void XV_HdmiTxSs_SetAudioChannels(XV_HdmiTxSs *InstancePtr, u8 AudioChannels);
   ```

   Example:

   ```c
   XV_HdmiTxSs_SetAudioChannels(&HdmiTxSs, N);
   ```

3. To demo using example design application software, update the following section of codes in xhdmi_example.c:

   ```c
   /* Enable 2-channel audio */
   XhdmiAudGen_SetEnabChannels(&AudioGen, 2);
   XhdmiAudGen_SetPattern(&AudioGen, 1, XAUD_PAT_PING);
   XhdmiAudGen_SetPattern(&AudioGen, 2, XAUD_PAT_PING);
   ```

   Example: To support 8 channel audio:

   ```c
   /* Enable 8-channel audio */
   XhdmiAudGen_SetEnabChannels(&AudioGen, 8);
   XhdmiAudGen_SetPattern(&AudioGen, 1, XAUD_PAT_PING);
   XhdmiAudGen_SetPattern(&AudioGen, 2, XAUD_PAT_PING);
   XhdmiAudGen_SetPattern(&AudioGen, 3, XAUD_PAT_PING);
   XhdmiAudGen_SetPattern(&AudioGen, 4, XAUD_PAT_PING);
   ```
XhdmiAudGen_SetPattern(&AudioGen, 5, XAUD_PAT_PING);
XhdmiAudGen_SetPattern(&AudioGen, 6, XAUD_PAT_PING);
XhdmiAudGen_SetPattern(&AudioGen, 7, XAUD_PAT_PING);
XhdmiAudGen_SetPattern(&AudioGen, 8, XAUD_PAT_PING);

**Note:** If you enable 8 channel audio in your design, only 6 out of 8 channels are used to carry valid audio data. For the unused channels, you must pack the audio data with zeros by muting them.

XhdmiAudGen_SetPattern(&AudioGen, 7, XAUD_PAT_MUTE);
XhdmiAudGen_SetPattern(&AudioGen, 8, XAUD_PAT_MUTE);

To update the audio channel allocation.

Information can be found in Table 20 in CED-861-D, under Audio InfoFrame Data Byte 4.

In the API,

```c
void XV_HdmiTxSs_SendAuxInfoframe(XV_HdmiTxSs *InstancePtr, void *AuxPtr);
```

You must set the data byte value before calculating the CRC.

**Example**

```c
/* Channel Allocation */
```

You may choose to construct your own infoframe in the application software, and use API XV_HdmiTxSs_SendGenericAuxInfoframe to send out.

**Use Case 6: Enable HDMI Mode**

Use the following API:

```c
XV_HdmiTxSS_SetHdmiMode(&HdmiTxSs);
XV_HdmiTxSs_AudioMute(&HdmiTxSs, FALSE);
```

**Use Case 7: Enable DVI Mode**

Use the following API:

```c
XV_HdmiTxSS_SetDviMode(&HdmiTxSs);
XV_HdmiTxSs_AudioMute(&HdmiTxSs, TRUE);
```
Additional Resources and Legal Notices

**Xilinx Resources**

For support resources such as Answers, Documentation, Downloads, and Forums, see [Xilinx Support](https://www.xilinx.com).

**Documentation Navigator and Design Hubs**

Xilinx Documentation Navigator provides access to Xilinx documents, videos, and support resources, which you can filter and search to find information. To open the Xilinx Documentation Navigator (DocNav):

- From the Vivado IDE, select **Help > Documentation and Tutorials**.
- On Windows, select **Start > All Programs > Xilinx Design Tools > DocNav**.
- At the Linux command prompt, enter `docnav`.

Xilinx Design Hubs provide links to documentation organized by design tasks and other topics, which you can use to learn key concepts and address frequently asked questions. To access the Design Hubs:

- In the Xilinx Documentation Navigator, click the **Design Hubs View** tab.
- On the Xilinx website, see the [Design Hubs](https://www.xilinx.com) page.

*Note:* For more information on Documentation Navigator, see the [Documentation Navigator](https://www.xilinx.com) page on the Xilinx website.
Appendix E: Additional Resources and Legal Notices

References

These documents provide supplemental material useful with this product guide:

1. Xilinx Vivado AXI Reference Guide (UG1037)
2. Kintex UltraScale FPGAs Data Sheet: DC and AC Switching Characteristics (DS892)
3. Virtex UltraScale FPGAs Data Sheet: DC and AC Switching Characteristics (DS893)
4. Kintex-7 FPGAs Data Sheet: DC and AC Switching Characteristics (DS182)
5. Virtex-7 FPGAs Data Sheet: DC and AC Switching Characteristics (DS183)
6. Artix-7 FPGAs Data Sheet: DC and AC Switching Characteristics (DS181)
7. Zynq-7000 SoC: DC and AC Switching Characteristics (DS187)
8. Zynq-7000 SoC: DC and AC Switching Characteristics (DS191)
9. Kintex UltraScale+ FPGAs Data Sheet: DC and AC Switching Characteristics (DS922)
10. Virtex UltraScale+ FPGAs Data Sheet: DC and AC Switching Characteristics (DS923)
11. Zynq UltraScale+ MPSoC Data Sheet: DC and AC Switching Characteristics (DS925)
12. Zynq UltraScale+ RFSoC Data Sheet: DC and AC Switching Characteristics (DS926)
13. HDMI specifications (www.hdmi.org/manufacturer/specification.aspx)
14. HDCP specifications (www.digital-cp.com/hdcp-specifications)
15. AXI4-Stream Video IP and System Design Guide (UG934)
19. ISE to Vivado Design Suite Migration Guide (UG911)
20. KCU105 Board User Guide (UG917)
23. AXI Interconnect Product Guide (PG059)
25. HDCP v2.2 Product Guide (PG249)
26. HDCP v1.4 Product Guide (PG224)
27. AXI4-Stream to Video Out LogiCORE IP Product Guide (PG044)
# Revision History

The following table shows the revision history for this document.

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>02/12/2019</td>
<td>3.1</td>
<td>• Added HDCP Repeater functionality</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added Pass-through + I2S support</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added PCB design guidelines for TMDS181 &amp; DP159</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated Example Design steps</td>
</tr>
<tr>
<td>04/04/2018</td>
<td>3.1</td>
<td>• Added new board support (ZCU104, ZCU106, VCU118).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added new Example design features.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated Example Design steps</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added Migrating and upgrading section</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added debug information</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated AXI-Lite CPU clock supports</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated YUV420 remapping feature illustration</td>
</tr>
<tr>
<td>12/20/2017</td>
<td>3.0</td>
<td>• Updated Example Design steps</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added notes for DP159 Settings.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated notes for CPU clock requirements</td>
</tr>
<tr>
<td>10/04/2017</td>
<td>3.0</td>
<td>• Added Example design topology supports (TX-Only, Pass-through).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added Example design VPHY Configuration Support (NI-DRU Enable/ Disable, TXPLL selection, RXPLL selection).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added Example design new board supports (ZCU102).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added SDK application supports (TX, Pass-through and HDCP key utility).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added Information for Example design description.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added Software Flow diagram.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added Information if not all audio channels are used.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added Information about Native Video.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added Information about Interlaced Video.</td>
</tr>
<tr>
<td>04/05/2017</td>
<td>2.0</td>
<td>• Removed single pixel per clock support</td>
</tr>
<tr>
<td>11/30/2016</td>
<td>2.0</td>
<td>• Added example design migration notes.</td>
</tr>
<tr>
<td>10/05/2016</td>
<td>2.0</td>
<td>• Added example design flow.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added HPD XGUI option.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Added software use cases.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Updated Xilinx <strong>AUTOMOTIVE APPLICATIONS DISCLAIMER.</strong></td>
</tr>
<tr>
<td>06/08/2016</td>
<td>2.0</td>
<td>• Updated optional video over AXI-Stream support.</td>
</tr>
</tbody>
</table>
Please Read: Important Legal Notices

The information disclosed to you hereunder (the “Materials”) is provided solely for the selection and use of Xilinx products. To the maximum extent permitted by applicable law: (1) Materials are made available “AS IS” and with all faults, Xilinx hereby DISCLAIMS ALL WARRANTIES AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether in contract or tort, including negligence, or under any other theory of liability) for any loss or damage of any kind or nature related to, arising under, or in connection with, the Materials (including your use of the Materials), including for any direct, indirect, special, incidental, or consequential loss or damage (including loss of data, profits, goodwill, or any type of loss or damage suffered as a result of any action brought by a third party) even if such damage or loss was reasonably foreseeable or Xilinx had been advised of the possibility of the same. Xilinx assumes no obligation to correct any errors contained in the Materials or to notify you of updates to the Materials or to product specifications. You may not reproduce, modify, distribute, or publicly display the Materials without prior written consent. Certain products are subject to the terms and conditions of Xilinx’s limited warranty, please refer to Xilinx’s Terms of Sale which can be viewed at https://www.xilinx.com/legal.htm#tos; IP cores may be subject to warranty and support terms contained in a license issued to you by Xilinx. Xilinx products are not designed or intended to be fail-safe or for use in any application requiring fail-safe performance; you assume sole risk and liability for use of Xilinx products in such critical applications, please refer to Xilinx’s Terms of Sale which can be viewed at https://www.xilinx.com/legal.htm#tos.

AUTOMOTIVE APPLICATIONS DISCLAIMER

AUTOMOTIVE PRODUCTS (IDENTIFIED AS “XA” IN THE PART NUMBER) ARE NOT WARRANTED FOR USE IN THE DEPLOYMENT OF AIRBAGS OR FOR USE IN APPLICATIONS THAT AFFECT CONTROL OF A VEHICLE (“SAFETY APPLICATION”) UNLESS THERE IS A SAFETY CONCEPT OR REDUNDANCY FEATURE CONSISTENT WITH THE ISO 26262 AUTOMOTIVE SAFETY STANDARD (“SAFETY DESIGN”). CUSTOMER SHALL, PRIOR TO USING OR DISTRIBUTING ANY SYSTEMS THAT INCORPORATE PRODUCTS, THOROUGHLY TEST SUCH SYSTEMS FOR SAFETY PURPOSES. USE OF PRODUCTS IN A SAFETY APPLICATION WITHOUT A SAFETY DESIGN IS FULLY AT THE RISK OF CUSTOMER, SUBJECT ONLY TO APPLICABLE LAWS AND REGULATIONS GOVERNING LIMITATIONS ON PRODUCT LIABILITY.

© Copyright 2015–2019 Xilinx, Inc. Xilinx, the Xilinx logo, Artix, ISE, Kintex, Spartan, Virtex, Vivado, Zynq, and other designated brands included herein are trademarks of Xilinx in the United States and other countries. All other trademarks are the property of their respective owners.